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Product Basics

See these sections to learn about the basic features of your product.

Product Parts Locations

Using the Control Panel

Using Power Saving Settings

Using the Epson Smart Panel Mobile App
Voice-activated Printing

Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint

Setting Up Printing on a Chromebook

Android Printing Using the Epson Print Enabler

Using Fire OS Printing

Using Windows 10 Mobile Printing

Using Epson Print and Scan App with Windows Tablets
Using the Mopria Print Service

Product Parts Locations

See these sections to identify the parts on your product.

Product Parts - Front
Product Parts - Inside
Product Parts - Back

Parent topic: Product Basics
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Product Parts - Front

a b WN -

Front cover

Output tray

Cassette 1 (upper cassette)
Cassette 2 (lower cassette)
Cassette edge guides
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6  Paper guide extension

Rear paper feed slot

Rear paper feed slot cover
Edge guides

CD/DVD tray slot

A W N -
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5 CD/DVD tray
Parent topic: Product Parts Locations

Product Parts - Inside

1 Document cover
2  Scanner glass
3  Memory card slot
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4 A USB port for external USB devices

(5

(4

1 Scanner unit

2 Ink cartridge holder

3 Maintenance box cover
4  Control panel

5 O power button and light

Parent topic: Product Parts Locations
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Product Parts - Back

1 AC inlet
2  Rear cover (duplexer)

3 USB port for computer connections
Parent topic: Product Parts Locations

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons and Lights
Adjusting the Control Panel Position
The LCD Screen

Status Icon Information

Navigating the LCD Screen

Entering Characters on the LCD Screen
Changing LCD Screen Language
Adjusting Control Panel Sounds
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Adjusting the Screen Brightness
Viewing Animations
Turning Off Auto Selection Mode

Parent topic: Product Basics

Control Panel Buttons and Lights
(1 (2

|
|

©

1 O power button and light
2 LCD screen

Parent topic: Using the Control Panel
Related references

The LCD Screen

Status Icon Information

Navigating the LCD Screen

Related tasks

Entering Characters on the LCD Screen
Viewing Animations
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Adjusting the Control Panel Position

You can adjust the position of the control panel to make it easier to access. Raise or lower it to the
desired angle as shown.

Parent topic: Using the Control Panel

The LCD Screen

|
(5]

1 Displays supply status information

21



Network status icons (press for additional options)
Enables or disables Quiet Mode

Displays help information

Menu options

Displays additional menu options

N O o A WN

Stores the output tray

(1) 2]

Advanced Setting

v
YIS

|
) o

Return to previous screen
Select a tab to view different options and settings
Setting options

A WO N -

Displays available options

Parent topic: Using the Control Panel
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Status Icon Information
Your product displays status icons on the LCD screen for certain product status conditions. Press the

[

L L icon to view or change the current network settings.

Description

Displays additional information or instructions, such as loading paper or placing a
document.

Displays the Supply Status screen.

Quiet Mode is enabled. Noise is reduced during printing, but the print speed may be
reduced. Press this icon to change the settings.

Quiet Mode is disabled. Press this icon to change the settings.

There is a problem with the indicated setting. Press the icon to resolve the problem.

This product is not connected to a wireless network.

The product is searching for an SSID or experiencing a wireless network connection issue.

The product is connected to a wireless network; the number of bars indicates the
connection's signal strength.

Wi-Fi Direct is not enabled.

Wi-Fi Direct is enabled.

slalEEEREE R

%)

Parent topic: Using the Control Panel

Navigating the LCD Screen

Follow these guidelines to navigate and use the menus on the LCD screen.

% Tap or press the screen to select an item or icon
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i Flick the screen to scroll swiftly

"b Slide your finger across the screen to move items

"

xg7> Close or open your fingers across the screen to zoom in or zoom out on a preview image
W
To change a setting, tap anywhere on the setting.

@ Faper Souwcs 30mng

Paper Selup

Fapgr Contiguraigs
@ PeEe o @

To enter a value in a field, tap the field to display the on-screen keyboard.

Enter Manually

{’n\_\ Enber Passwond @
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Parent topic: Using the Control Panel

Entering Characters on the LCD Screen
Follow these guidelines to enter characters for passwords and other settings.

On-screen keyboard
® ¢
e | 0/63 E)

awie|r|tiyiuli|o|p

als|d|f(g | h|J[k[l]]|-

z|(x|c v|b|n mEg&
00

Displays the character count

Moves the cursor left or right

Switches between uppercase and lowercase characters
Switches between characters and numbers or symbols
Changes the keyboard layout

Displays a list of common domain names to choose from
Enters a space

Select when you are finished

© 00 N O 0o b WON -

Deletes the previous character

On-screen keypad
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(1-99Capies)

20 OF
NONON 2

]
(1] 0600

Cancels entry and closes the keypad

Select when you are finished
Clears the entered number

A WODN -~

Deletes the previous number
Parent topic: Using the Control Panel

Changing LCD Screen Language
You can change the language used on the LCD screen.
1. Press the 0 home icon, if necessary.
2. Select Settings.
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You see a screen like this:

3 Sahngs

Supply Stabyus

{F\I_\ Basic Settings I @

Prinfer Sattings

Meteork Setlings

Select Basic Settings.
Scroll down and select Language.
Select a language.

IR

Press the 9> home icon to exit.
Parent topic: Using the Control Panel

Adjusting Control Panel Sounds

You can adjust the sound level heard when you press buttons on the control panel.
1. Press the 0 home icon, if necessary.
2. Select Settings.
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You see a screen like this:

3 Sahngs

Supply Stabyus

{F\I_\ Basic Settings I @

Prinfer Sattings

Meteork Setlings

3. Select Basic Settings.
4. Select Sound.
5. Select Normal Mode or Quiet Mode.

Note: You can also press the icon on the home screen to switch between Normal Mode and
Quiet Mode.
6. Do one of the following:
+ Select Button Press.
» Select Error Tone.
7. Press the — or + icon to adjust the volume.
8. Select OK to exit.
Parent topic: Using the Control Panel

Adjusting the Screen Brightness
You can adjust the brightness of the LCD screen.
1. Press the 90 home icon, if necessary.
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2. Select Settings.

9 Saltings

Supply Stabyus

‘[& Basic Settings | @

Prinfer Sattings

Metwork Setlings W

3. Select Basic Settings.
4. Select LCD Brightness.

Cancel LED Bighinoss m

5 5 -
e —s—s—0o—9 ﬂ

Note: If you want to change the background color entirely, select Background Color.

5. Press the — or + button to adjust the brightness.
6. Select OK to exit.

Parent topic: Using the Control Panel
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Viewing Animations

You can view animations on the LCD screen to help guide you with a procedure or to troubleshoot a
problem.

1. Select the ® help icon.
You see a screen like this:

)

Troubla
Ehoaiting

How To...

2. Select Troubleshooting if you are experiencing a problem or How To to view instructions on
common procedures.

3. Select a topic from the list of available topics and follow the on-screen instructions.
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While viewing the topics, you may see screens like this:

When Output Tray is open, push to close it
and pull out Paper Cassette 2.
C : )

|
©

Displays the current step number and the total number of steps
Press the left arrow button to view the previous step

Indicates your overall progress through the animation

Press the right arrow button to view the next step

A WO DN -

Parent topic: Using the Control Panel

Turning Off Auto Selection Mode

Auto Selection Mode changes the menu options on the LCD screen automatically depending on the
action you perform. For example, loading a memory card automatically displays memory card-related
menu options on the screen. You can turn off this feature if desired.

1. Press the 9 home icon, if necessary.
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2. Select Settings.
You see a screen like this:

Supply Stabus
'i; [ Basic Seltings | @
Printar Satlings

Metwork Settings

Scroll down and select Guide Functions.
Select Auto Selection Mode.
Turn off this mode for the desired options displayed on the screen.

o ok~ w

Press the 41t home icon to exit.
Parent topic: Using the Control Panel

Using Power Saving Settings

Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period
of time. You can make the time period shorter and select other options to save energy and resources.

Changing the Sleep Timer Settings
Changing the Power Off Timer Settings

Parent topic: Product Basics

Changing the Sleep Timer Settings

You can adjust the time period before your product enters sleep mode and turns off the LCD screen.
1. Press the 90 home icon, if necessary.
2. Select Settings.
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You see a screen like this:

@ s

Supply Stabyus

{F\I_\ Basic Settings I @

Prinfer Sattings

Meteork Setlings

3. Select Basic Settings.

4. Scroll down and select Sleep Timer.

5. Select a time period between 3minutes and 15minutes.
Parent topic: Using Power Saving Settings

Changing the Power Off Timer Settings

You can have the product turn off automatically if it is not used for a specified period of time.
1. Press the 90 home icon, if necessary.
2. Select Settings.
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You see a screen like this:

@ s

Supply Stabyus
f.'l\ Basic Settings | @
Prinfer Sattings

Meteork Setlings

3. Select Basic Settings.

4. Scroll down and select Power Off Timer.

5. Select a time period between 30minutes and 12h (12 hours).
Parent topic: Using Power Saving Settings

Using the Epson Smart Panel Mobile App

Use this free Apple and Android app to set up your Epson product and then print, copy, or scan with your
networked Epson product. Epson Smart Panel also lets you check ink levels and product status.

1. Visit epson.com/connect (U.S.) or epson.ca/connect (Canada) to learn more about Epson Smart
Panel and check the compatibility of your mobile device.

2. Download Epson Smart Panel from the Apple App Store or Google Play.

3. Connect your mobile device to the wireless network that you want to connect your product to or to
the same wireless network as your product (if your product is already set up).

4. Do one of the following:

 If you haven't set up your product, open Epson Smart Panel and follow the instructions to set up
your product.

« If your product is already set up, open Epson Smart Panel and select your Epson product, if
necessary.

Now you are ready to print, copy, or scan with your mobile device and your Epson product.
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Parent topic: Product Basics

Voice-activated Printing

Take advantage of voice-activated, hands-free printing from your Epson product with Alexa, Siri, and
Google Assistant. Depending on which voice assistant you use, you can ask your product to print
photos, calendars, recipes, photo props, and more. Click here for more information.

1. Connect your product to your network. See the link below.

2. Setup your product's email address for use with Epson Connect. See the link below to activate it
from the product control panel.

3. Click here for instructions on how to set up your product and voice assistant to use the voice-
activated printing feature.

Now you are ready to print with your voice and your Epson product.
Parent topic: Product Basics

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print and scan documents, photos, emails, and web pages
from your home, office, or even across the globe.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Print from anywhere with these Epson Connect solutions:
* Epson Email Print
* Epson Remote Print

Scan and send a file as an email or upload it to an online service directly from your Epson product with
Epson Scan to Cloud.

Setting Up Epson Connect Services

Using Epson Email Print

Using the Epson Creative Print Mobile App
Using Epson Remote Print

Using Epson Scan to Cloud

35


https://epson.com/voice
https://epson.com/voice

Parent topic: Product Basics

Setting Up Epson Connect Services

If you did not activate your product's email address for use with Epson Connect when you set up your
product, you can activate it using the product control panel.

1. Press the 0 home icon, if necessary.
2. Select Settings.
You see a screen like this:

@ s

Supply Stabyus

{F\I_\ Basic Settings I @

Prinfer Sattings

Meteork Setlings

3. Select Web Service Settings.
4. Select Epson Connect Services.
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You see a screen like this:

9 Epaon Conmec

Rogistration
Linregistored

A @

5. Select Register.
6. Follow the instructions on the screen to activate your product's email address.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi Networking

Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the
attachments will print automatically.

1. Connect your product to your network. See the link below.

2. Ifyou did not already set up Email Print when you installed your product software, see the link below
to use your product control panel to activate your unique email address. Or visit epson.com/connect
(U.S.) or epson.ca/connect (Canada) to learn more about Email Print, create your Epson Connect
account, and register your product to the Epson Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

Note: Go to epsonconnect.com and log into your Epson Connect account to personalize your product's
email, adjust print settings, and set up other Epson Connect services.
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Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi Networking

Using the Epson Creative Print Mobile App
Use this free Apple and Android app to do the following:

» Access and print your mobile device photos, including Instagram and Facebook photos

» Create custom greeting cards and stationery
* Print onto CD/DVDs
» Turn photos into coloring book templates

Note: Not all features may be supported by your product.

3.
4.
5.

Connect your product to your wireless network. See the link below.

Visit epson.com/connect (U.S.) or epson.ca/connect (Canada) to learn more about Epson Creative
Print and check the compatibility of your mobile device and your Epson product.

Download Epson Creative Print from the Apple App Store or Google Play.
Connect your mobile device to the same wireless network that your product is using.
Open Epson Creative Print.

Now you are ready to get creative with your mobile device and your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi Networking

Using Epson Remote Print

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson
Email-enabled product anywhere in the world.

1.

Connect your Epson product to your wireless network. See the link below.
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2. If you did not already set up an Epson Connect account when you installed your product software,
visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address.

3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print
Driver software.

4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.

6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer
application and choose the Remote Print option for your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi Networking

Using Epson Scan to Cloud

The Epson Scan to Cloud service allows you to scan and send a file as an email or upload it to an online
service directly from your Epson product. Register an email address or online services such as Box,
DropBox, Evernote, or Google Drive with your Epson Connect account.

1. Connect your Epson product to your network. See the link below.

2. Ifyou did not already set up an Epson Connect account when you installed your product software,
visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address and password.

3. Visit epsonconnect.com to sign into your account with the email address and password you
selected.

4. Select your product, select Scan to Cloud, and select Destination List.
Click Add, then follow the instructions on the screen to create your destination list.

6. Now you are ready to use Scan to Cloud. Select the setting for scanning to Scan to Cloud on your
Epson product control panel.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
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Related topics
Wi-Fi Networking

Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, iPod touch, and Mac without the need to
install drivers or download software.

Works with

|
= Apple AirPrint

Note: If you disabled paper configuration messages on your product control panel, you cannot use
AirPrint. See the link below to enable the messages, if necessary.

Load paper in your product.
Set up your product for wireless printing. See the link below.
Connect your Apple device to the same wireless network that your product is using.

b=

Print from your device to your product.
Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics

Related tasks
Turning Off the Paper Mismatch Alert

Related topics
Wi-Fi Networking

Setting Up Printing on a Chromebook

Your Epson printer supports native printing on Chromebook, allowing you to print from a Chromebook
without drivers or cables.

For directions on setting up your printer, visit Setting Up Your Epson Printer on Your Chromebook (U.S.)
or Setting Up Your Epson Printer on Your Chromebook (Canada).

Parent topic: Product Basics
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Android Printing Using the Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone
or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson
product and print.

1.

o &~ DN

Connect your Epson product to your wireless network. See the link below.

On your Android device, download the Epson Print Enabler plug-in from Google Play.

Go to Settings on your Android device, select Printing, and enable the Epson plug-in, if necessary.
Connect your Android device to the same wireless network as your product.

Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu
icon and print whatever is on the screen.

Note: If you do not see your product, tap All Printers and select your product.

Parent topic: Product Basics

Related topics
Wi-Fi Networking

Using Fire OS Printing

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product.
There is no software to download, no drivers to install, and no cables to connect. With just a few taps in
Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson
product.

1.
2.
3.

Connect your Epson product to your wireless network. See the link below.
Connect your Amazon device to the same wireless network as your product.

Now you are ready to print. From your Amazon application, tap the print option and select your
product to print whatever is on the screen.

Note: If you see a message telling you that a plug-in is required, tap OK and tap Download. If your
Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria
Print Service app to print.

Parent topic: Product Basics
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Related topics
Wi-Fi Networking

Using Windows 10 Mobile Printing

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson
product. There is no software to download, no drivers to install, and no cables to connect. Look for the
print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.

3. Now you are ready to print. From your Windows 10 application, tap the print option and select your
product to print whatever is on the screen.

Parent topic: Product Basics

Related topics
Wi-Fi Networking

Using Epson Print and Scan App with Windows Tablets

You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface
RT or Pro tablet with networked Epson products. The Epson Print and Scan app allows you to scan and
capture images right to your tablet or to Microsoft OneDrive.

Note: The Epson Print and Scan app does not support Windows 10 Mobile printing and does not supply
scanning functions for products without scanners.

Connect your Epson product to your wireless network. See the link below.
Download the Epson Print and Scan app from the Microsoft Windows Store.
Connect your Windows tablet to the same wireless network as your product.

b~

Open the Epson Print and Scan app and select your Epson product.
Now you are ready to print photos or scan.
Parent topic: Product Basics

Related topics
Wi-Fi Networking
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Using the Mopria Print Service

You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to
your Epson product or any Mopria-certified product from other manufacturers. You can download the
Mopria Print Service from Google Play.

Note: For details on the Mopria Print Service, click here (U.S.) or click here (Canada).

Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Mopria Print Service app from Google Play.

Note: On some Samsung Galaxy devices, Mopria may come preinstalled.

3. Go to Settings on your Android device, select Printing, and enable the Mopria Print Service, if
necessary.

4. Connect your Android device to the same wireless network as your product.

5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu
icon and select Print. Then select All printers, select your Epson product, adjust your print settings,
and print.

Parent topic: Product Basics

Related topics
Wi-Fi Networking
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Wi-Fi Networking

See these sections to use your product on a Wi-Fi network.

Network Security Recommendations

Wi-Fi Infrastructure Mode Setup

Setting Up Wireless Printing from a Smartphone or Tablet
Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

Printing a Network Connection Report

Changing or Updating Network Connections

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:

Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

Connect your product only to a network protected by a firewall

Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

Change the default administrator password on your product

If your product has an option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi Networking
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Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

Epson product

Wireless router or access point
Computer with a wireless interface
Computer

Internet

oo o0~ WDN -

Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings from the Control Panel
Parent topic: Wi-Fi Networking
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Selecting Wireless Network Settings from the Control Panel
You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software by downloading it from the Epson website. The installer program guides you
through network setup.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

1. Press the 90 home icon, if necessary.
2. Select the icon.

You see a screen like this:

= Hotwork Connocion
Lloie  ERRipes

Solest Conndetion Mot

> = o

Select Wi-Fi (Recommended).

Select Start Setup or Change Settings.
Select Wi-Fi Setup Wizard.

Select the name of your wireless network or select Enter Manually to enter the name manually. Use
the displayed keyboard to enter your network name.
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7. Select the Enter Password field and enter your wireless password using the on-screen keyboard.

a I on3 ik

giwle r t vy uw l e p
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Zlx|¢|vy | b|n|m
s |

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

* To move the cursor, press the left or right arrows.
* To change the case of letters, select .

» To delete the previous character, select .

» To enter numbers and symbols, select H

* To enter a space, select El
8. Select OK when you finish entering your password.
9. Confirm the displayed network settings and select Start Setup to save them.
10. Do one of the following:

+ If setup was successful, select Close to exit. (This screen will automatically close after a few
seconds.)

* If setup was unsuccessful, select Print Check Report to print a network setup report or select Re-
enter to re-enter your network name and password.

11. Press the 90 home icon to return to the Home screen.
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The Wi-Fi icon displayed on the LCD screen indicates your wireless connection status. If the
product is not connected to the network, you may have selected the wrong network name or entered
the password incorrectly. Repeat these steps to try again.

If you are printing from a computer, make sure you installed the network software as described on
the Start Here sheet.

Parent topic: Wi-Fi Infrastructure Mode Setup

Related references
Status Icon Information

Related tasks
Entering Characters on the LCD Screen

Setting Up Wireless Printing from a Smartphone or Tablet

You can use the Epson Smart Panel app to connect your Epson product to a wireless network or
connect your device directly to the product. Epson Smart Panel is available on iOS and Android devices.

Make sure you have the following:

* A Bluetooth-enabled device that is connected to a wireless network
* The Epson Smart Panel app installed on the device

* The wireless network name (SSID) and password

Note: Your device must be close enough to the product to create and maintain a Bluetooth connection.
1. Make sure the product is turned on and is ready to print.
Note: You must perform initial setup and ink installation before setting up wireless printing.

Open the Epson Smart Panel app on your device.
3. Do one of the following:

+ If the app automatically recognizes the product, follow the on-screen instructions to set up the
wireless connection.

+ If the app does not automatically recognize the product, select the + icon and continue with the
next step.
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4. On the next screen, select Start setting up and follow the on-screen instructions.

Note: If your product is not listed, move closer to the product and try again. If the product is still not
shown, connect your printer to the wireless network using the control panel and then select Connect
Smartphone to Product Already Connected to Wi-Fi in the Epson Smart Panel app and follow the
on-screen instructions. See the link below for wireless setup instructions.

Your product is now connected to a wireless network and set up for use with the Epson Smart Panel
app.

Parent topic: Wi-Fi Networking
Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network
access point for up to devices.

L7 (ks

1 Epson product
2  Computer with a wireless interface
3  Other wireless device

Enabling Wi-Fi Direct Mode (Simple AP)
Parent topic: Wi-Fi Networking
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Enabling Wi-Fi Direct Mode (Simple AP)

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer,
mobile devices, or other devices (up to 8) without a wireless router or access point.

Note: Make sure the Epson Smart Panel app or another compatible Epson printing app is installed on
your mobile device before connecting to the product.

Press the 4 home icon, if necessary.
2. Select Smartphone connect.
« If your product is not connected to a wireless network, go to the next step.

* If your product is already connected to a wireless network, select Other Methods and then
continue to the next step.

3. Select Start Setup.
Select Other Methods.
5. Do one of the following:

» ForiOS devices, select iOS. Scan the QR code with the camera app on your device and follow the
instructions on your device.

» For other types of devices, select Other OS Devices. Press the down arrow button to display the
product information, then use your device to select the Wi-Fi network name (SSID) displayed on
the LCD screen and enter the password shown.

6. Open the Epson Smart Panel app (or another compatible Epson printing app) on your device, then
press the down arrow button on your product's control panel to view the product information. Use the
information on the product's LCD screen to select your product in the Epson Smart Panel app.

7. Select Complete on the LCD screen.
The Wi-Fi Direct icon is displayed on the LCD screen and indicates if Wi-Fi Direct is enabled on
the product.

Parent topic: Wi-Fi Direct Mode Setup

Related references
Status Icon Information

Related tasks
Using the Epson Smart Panel Mobile App
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Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Press the 90 home button, if necessary.

2. Pressthe icon.

You see a screen like this:

= Motwork Connection
Llose RSN

Solect Conndction Mo
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3. Select Wi-Fi (Recommended).
4. Select Start Setup.
5. Select Push Button Setup (WPS).
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6. Follow the instructions on the LCD screen to complete WPS setup.
7. Press the fi* home button to exit.

You see the icon on the LCD screen and should be able to connect to your product directly
from your computer or device, and then print. If you are printing from a computer, make sure you
installed the network software as described on the Start Here sheet.

Note: If you don't see the icon, repeat these steps to try again.
Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Make sure a few sheets of plain paper are loaded in the lower cassette.
2. Press the 90t home button, if necessary.
3. Select Settings.

You see a screen like this:

@ s

Supply Stabus

Q Basic Settings I @

Printar Satlings

Metwork Settings

4. Select Network Settings > Network Status.
5. Select Print Status Sheet.
6. Select Print.
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Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi Networking

Printing a Network Connection Report

You can print a network connection report to view solutions to any problems you may have using your
product on a network.

1. Make sure a few sheets of plain paper are loaded in the lower cassette.
2. Press the 7 home icon, if necessary.
3. Select Settings.

You see a screen like this:

Supply Stabyus

{F\I_\ Basic Settings | @

Prinfer Sattings

Meteork Setlings

4. Select Network Settings > Connection Check.
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You see a screen like this:

= Connocion GCheck

Metwork conneclion verified.
‘LI/'D Print the Connection Check Report @
for details.

Print Check Ropodt _

5. Select Print Check Report to print the network connection report.

Examine any error codes and solutions shown on the network connection report.
Network Connection Report Codes and Messages

Parent topic: Wi-Fi Networking

Network Connection Report Codes and Messages

Check the error codes and messages on the network connection report to solve problems you may
encounter with network connections. The tables here list solutions to problems based on the error codes
and messages that may appear on the top of the report.

heck Metwark Conamcticon

Check Rasult FATL

Errar cods [r!-’-i'l Y

Bse the Hetwork Status and check Lf the Hetwork Name [S5I0} is
tha SEID you wAAR O conmeot,

If the SSI0 is cocrect, make #use Lo GAbes Lhe COCXOCE PasEWord
and try sgain.

If your problems persist,
md your desussntaticn for halp and networking tipa.
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1 Error code
2  Message

Note: Error codes and messages listed here may not all apply to your product.

Error Codes and Messages

Error code and message Solution

E-1 Make sure your router, access point, and/or hub are
turned on, and the network cable is securely connected to

Confirm that the network cable is :
your device and to your product.

connected and network devices such as
hub, router, or access point are turned on. |If you are trying to set up Wi-Fi, remove the network cable
and set up Wi-Fi again. Ethernet and Wi-Fi cannot be
connected at the same time.
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Error code and message

Solution

E-2, E-3, or E-7

No wireless network names (SSID) found.
Confirm that the router/access point is
turned on and the wireless network (SSID)
is set up correctly. Contact your network
administrator for assistance.

No wireless network names (SSID) found.
Confirm that the wireless network name
(SSID) of the PC you wish to connect is set
up correctly. Contact your network
administrator for assistance.

Entered security key/password does not
match the one set for your router/access
point. Confirm security key/password.
Contact your network administrator for
assistance.

Check the following:

Make sure your router or access point is turned on, and
is correctly connected to your computer or network
device.

Turn off the router or access point, wait about 10
seconds, and turn it on again.

Move your product closer to your router or access point,
and remove any obstacles between them. Also move
your product away from devices such as wireless
phones or microwaves.

Confirm that the SSID shown on the network
connection report matches the label on your router or
access point. Also make sure your SSID uses only
ASCII characters and symbols, or your product cannot
display the SSID correctly.

If you are trying to connect using the WPS push button
method, make sure your router or access point supports
it.

If you are using a network password, check the label on
your router or access point to confirm that you are using
the correct password, or check with your network
administrator or router/access point documentation.

If you are connecting to a smart device that generates
an SSID, check the device documentation for the SSID
and password you should use.

If your wireless connection suddenly disconnects, and
another smart device was added to the network using a
WPS push button method or your network was set up
using a non-WPS push button method, try downloading
and installing your product software again.
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Error code and message

Solution

E-5

Security mode (e.g. WEP, WPA) does not
match the current setting of the printer.
Confirm security mode. Contact your
network administrator for assistance.

If the security on your router or access point is not one of
the following types, change the type of security on your
router or access point and reset your product's network
settings.

WEP-64 bit (40 bit)

WEP-128 bit (104 bit)

WPA PSK (TKIP/AES); also known as WPA Personal
WPA2 PSK (TKIP/AES); also known as WPA2 Personal
WPA (TKIP/AES)

WPA2 (TKIP/AES)

WPA3-SAE (AES)

E-6

MAC address of your printer may be
filtered. Check whether your router/access
point has restrictions such as MAC address
filtering. See the documentation of the
router/access point or contact your network
administrator for assistance.

If your router or access point has MAC address filtering
enabled, register your product's MAC address so it is not
filtered. Locate the MAC address on the network
connection report and check your router or access point
documentation for instructions.

If your router or access point is using shared
authentication with WEP security, confirm that you are
using the correct authentication key and index.

If your router or access point limits the number of
connected devices, raise the connection limit. See your
router or access point documentation for instructions.

E-8

Incorrect IP address is assigned to the
printer. Confirm IP address setup of the
network device (hub, router, or access
point). Contact your network administrator
for assistance.

If your product's Obtain IP Address setting is set to Auto,
enable DHCP on your router or access point. Ifitis set to
Manual, the IP address may be out of range oron a
different network segment; set a valid IP address using
your product control panel or the Web Config utility.

You can also try turning off your product and the router or
access point, waiting about 10 seconds, and turning them
on again.

57




Error code and message

Solution

E-9

Confirm the connection and network setup
of the PC or other device. Connection using
the EpsonNet Setup is available. Contact
your network administrator for assistance.

Make sure your computer or network device are turned
on. Also make sure that you can access the Internet and
other devices on the same network from the devices you
are trying to connect to your product.

If you still cannot connect to your product, turn off your
router or access point, wait about 10 seconds, and turn it
on again. Download and install your product software
again to reset your network settings.

E-10

Confirm IP address, subnet mask, and
default gateway setup. Connection using
the EpsonNet Setup is available. Contact
your network administrator for assistance.

Make sure other devices on the network are turned on and
do the following:

If your product's Obtain IP Address setting is set to
Manual, check the IP address, subnet mask, and
default gateway addresses on the network connection
report to see if they are correct. If not, correct the
settings.

If DHCP is enabled, set your product's Obtain IP
Address setting to Auto. If you want to use the DHCP-
assigned address as a static address, set the Obtain IP
Address setting to Manual, enter the product's IP
address as listed on the network connection report, and
set the subnet mask to 255.255.255.0.

If you still cannot connect to your product, turn off your
router or access point, wait about 10 seconds, and turn it
on again.

E-11

Setup is incomplete. Confirm default
gateway setup. Connection using the
EpsonNet Setup is available. Contact your
network administrator for assistance.

If you set your product's TCP/IP Setup setting to Manual,
check that the default gateway address listed on the
network connection report is correct. Also turn on the
device that is set as the default gateway.
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Error code and message Solution

E-12 Make sure other devices on the network are turned on and

Confirm the following: do the following:

* Make sure the IP address, subnet mask, and default
gateway addresses are correct, if you are entering them

-Index of the security key/password is setto| manually.

the first number

-Entered security key/password is correct

» Confirm that the subnet mask and default gateway
-IP address, subnet mask, or default addresses for other devices are the same.

gateway setup is correct » Make sure the IP address does not conflict with other

Contact your network administrator for devices.

assistance. If you still cannot connect to your product, do the

following:

» Turn off your router or access point, wait about 10
seconds, and turn it on again.

* Download and install your product software again to
reset your network settings.

* If your router or access point uses WEP security with
several registered passwords, make sure that the first
registered password is set on your product.

E-13 Make sure your router, access point, and/or hub are
turned on. Also make sure the TCP/IP setup on your
router, access point, and/or hub is not set manually; this
-Entered security key/password is correct [ may cause your product's network settings to differ from
the manually set up devices.

Confirm the following:

-Index of the security key/password is set to
the first number If you still cannot connect to your product, do the

-Connection and network setup of the PC following:

or other device is correct » Turn off your router or access point, wait about 10

Contact your network administrator for seconds, and turn it on again.

assistance. * Download and install your product software again to
reset your network settings.

* If your router or access point uses WEP security with
several registered passwords, make sure that the first
registered password is set on your product.
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Network Environment Messages

Message

Solution

The Wi-Fi environment needs to be
improved. Turn the wireless router off and
then turn it on. If the connection does not
improve, see the documentation for the
wireless router.

Move your product closer to your router or access point,
and remove any obstacles between them. Then turn off
your router or access point, wait about 10 seconds, and
turn it back on again. If you still cannot connect to your
product, check the documentation that came with your
router or access point for solutions.

*No more devices can be connected.
Disconnect one of the connected devices if
you want to add another one.

You can connect up to 8 computers or other devices to
your product using a Wi-Fi Direct (Simple AP) connection.
If you want to add another device, disconnect an existing
connected device first.

The same SSID as Wi-Fi Direct exists in
the environment. Change the Wi-Fi Direct
SSID if you cannot connect a smart device
to the printer.

Change the Wi-Fi Direct SSID.

Parent topic: Printing a Network Connection Report

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection

Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features

Parent topic: Wi-Fi Networking

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: You can also access the Web Config utility from the product information area in the Epson Smart

Panel app.
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1. Print a network status sheet.
Locate the IP address for your product that is listed on the network status sheet.

3. On a computer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.

3. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related concepts
Uninstall Your Product Software

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation for instructions.

1. Do one of the following:
* Windows: Uninstall your product software.
* Mac: Go to the next step.
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2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related concepts
Uninstall Your Product Software

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the 9 home button, if necessary.
2. Pressthe icon.

You see a screen like this:

- Network Connpciion
Lloie  Epmipes

Solast Conndcton hathod.

'lu"g: -Fi
ﬁ:b (Recommanded) @

"I:::"' Wi-Fi Diroct

Select Wi-Fi (Recommended).
Select Change Settings.
Select Others.

Select Disable Wi-Fi.

Select Yes to disable Wi-Fi.

N o ok ow
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Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet
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Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in Cassette 1 (Upper Cassette)

Loading Paper in Cassette 2 (Lower Cassette)

Loading Paper in the Rear Paper Feed Slot

Turning Off the Paper Mismatch Alert

Paper Loading Capacity

Double-sided Printing Capacity

Available Epson Papers

Borderless Paper Type Compatibility

Selecting the Paper Settings for Each Source - Control Panel
Paper or Media Type Settings - Printer Software

Loading Paper in Cassette 1 (Upper Cassette)
You can load photo paper and other media in these sizes in the upper paper cassette:
+ 3.5 x5 inches (89 x 127 mm)
* 4 x6inches (102 x 152 mm)
* 5x7inches (127 x 178 mm)
* 16:9 wide (4 x 7.1 inches [102 x 181 mm])
A6 (4.1 x 5.8 inches [105 x 148 mm])

Note: Do not remove or insert the paper cassette during printing.
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1. Close the output tray by selecting the Output Tray icon on the Home screen, if necessary.

65



3. Slide out the upper paper cassette.

Note: If the cassette is too far inside the product to reach, turn the product off and on again to reset
the cassette's position.

4. Slide the edge guides outward.

© ]/
@[ﬂ‘_»
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Insert paper in the cassette with the glossy or printable side facedown.

Note: Make sure the paper is loaded against, but does not extend beyond, the rear edge of the
cassette.

Slide the side edge guides against the paper, but not too tightly.

o\zl/‘
» |
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Note: Make sure the paper fits under the tabs on the edge guides.

7. Keeping the cassette flat, slide it into your product.

8. Select the size and type of paper you just loaded on the product LCD screen, if prompted.
The output tray extends automatically when you print.
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Always follow these paper loading guidelines:
* Load only the recommended number of sheets.
» Load paper short edge first and printable side facedown.

» Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the
cassette.

» Check the paper package for any additional loading instructions.
Parent topic: Loading Paper

Related references

Double-sided Printing Capacity

Paper Loading Capacity

Paper or Media Type Settings - Control Panel

Related tasks

Loading Paper in Cassette 2 (Lower Cassette)

Loading Paper in the Rear Paper Feed Slot

Selecting the Paper Settings for Each Source - Control Panel

Loading Paper in Cassette 2 (Lower Cassette)
You can load paper up to this size in the lower paper cassette: Legal (8.5 x 14 inches [216 x 356 mm]).

Note: Do not remove or insert the paper cassette during printing.

1. Close the output tray by selecting the EXEEE Output Tray icon on the Home screen, if necessary.
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2. Open the front cover.

3. Pull on the front cover to slide out the lower paper cassette.

]|

T

1/

70



4. Slide the edge guides outward.

QO\E\/
- =

— ]

\\_—

5. Do one of the following:
* Insert paper with the glossy or printable side face down.
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* Insert up to 10 envelopes, printable side down and flap edge left, as shown.

N

» For legal-size paper, extend the legal-size paper guide as shown. Load paper with the glossy or
printable side facedown. Do not push on paper that extends beyond the cassette.
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6. Slide the side edge guides against the paper, but not too tightly.

— -

Note: Make sure the paper fits under the tabs on the edge guides.
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Keep the cassette flat as you slide it into your product.

Note: Leave enough space in front of the product for the paper to be fully ejected. Do not remove or
insert the paper cassette while the product is operating.

8. Select the size and type of paper you just loaded on the product LCD screen, if prompted.

The output tray extends automatically when you print.

Always follow these paper loading guidelines:

Load only the recommended number of sheets.
Load paper short edge first and printable side down.

Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the
cassette.

If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one
envelope at a time.

If print quality declines when printing multiple envelopes, try loading one envelope at a time.
Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references

Double-sided Printing Capacity

Paper Loading Capacity

Paper or Media Type Settings - Control Panel
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Related tasks

Loading Paper in Cassette 1 (Upper Cassette)

Loading Paper in the Rear Paper Feed Slot

Selecting the Paper Settings for Each Source - Control Panel

Loading Paper in the Rear Paper Feed Slot
You can print documents and photos on a variety of paper types and sizes using the rear paper feed slot.
1. Open the rear paper feed slot cover.

2. Slide the edge guides outward.

/
e
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3. Do one of the following:

* Insert one sheet of paper, glossy or printable side up and short edge first, centered at the arrow
mark.
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» Load one envelope centered at the arrow mark. Load it printable side up and flap edge left.

N

» Load a photo sticker centered at the arrow mark with the printable side up.
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Note: Do not load any carrier sheets into this product.

N

* Load one sheet of loose-leaf or other paper with holes facing as shown.

O
4 ¥

000000000000

000000000000
000000000000
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* Load one sheet of business card-sized paper glossy or printable side up and short edge first,
centered at the arrow mark.

N

Note: Make sure you load business card-sized paper vertically in the rear paper feed slot. You
may not be able to remove it if it is loaded horizontally.

4. Slide the edge guides against the paper, but not too tightly.

-

5. If prompted by the product's LCD screen, select the size and type of the paper you loaded.
The output tray extends automatically when you print.
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Always follow these paper loading guidelines:

* Load only the recommended number of sheets.

» Load paper short edge first, no matter which way your document faces.

* Load letterhead or pre-printed paper top edge first.

» Do not load envelopes that are curled, folded, or too thin, or that have plastic windows.
» Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references

Paper Loading Capacity

Double-sided Printing Capacity

Paper or Media Type Settings - Control Panel

Related tasks
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)

Turning Off the Paper Mismatch Alert

The Paper Mismatch Alert warns you when the paper settings do not match the paper you loaded. You
can turn off this feature from the product's control panel.

1. Press the 90 home button, if necessary.
2. Press the arrow buttons to select Settings.
3. Select Guide Functions.
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You see this screen:

3 Guito Functions

Fapar Miszmaich

{;\\ LheCunmpand Ao @
J O .

AL Selechan Mode

All sLngs

4. Select Paper Mismatch.

5. Set the Paper Mismatch setting to Off.
6. Select Close to exit.

Parent topic: Loading Paper

Paper Loading Capacity

You can load 1 sheet of paper or one envelope at a time in the rear paper feed slot. See the table here
for the loading capacity of the paper cassettes.

Paper type Load up to this many sheets
Cassette 2 (lower cassette) Cassette 1 (upper cassette)
Plain paper Letter (8.5 x 11 inches —

[216 x 279 mm]) and A4
(8.3 x 11.7 inches
[210 x 297 mm]) size: 100 sheets

Legal (8.5 x 14 inches
[216 x 356 mm]) size: 1 sheet

Epson Bright White Pro Paper 80 sheets —
Epson Presentation Paper Matte
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Paper type

Load up to this many sheets

Cassette 2 (lower cassette)

Cassette 1 (upper cassette)

Epson Premium Presentation
Paper Matte

20 sheets

Epson Photo Paper Glossy

Epson Premium Photo Paper
Glossy

Epson Ultra Premium Photo Paper
Glossy

Epson Premium Photo Paper
Semi-gloss

Epson Ultra Premium Photo Paper
Luster

20 sheets

20 sheets

Epson Premium Presentation
Paper Matte Double-sided

Epson Photo Quality Self-adhesive
Sheets

Epson Iron-on Cool Peel Transfer
paper

Epson Brochure & Flyer Paper
Matte Double-sided

1 sheet

Envelopes

10 envelopes

Parent topic: Loading Paper

Related references
Double-sided Printing Capacity
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Double-sided Printing Capacity

White Pro Paper [[216 x 279 mm]) and A4 (8.3 x 11.7

inches [210 x 297 mm])

Paper type Size Double-sided Printing Capacity
Auto Manual
Plain paper Letter (8.5 x 11 inches 100 sheets (cassette 2) 30 sheets
Copier paper |[r21c1:r?e); %27190n;|(n;]§))7arr1r<]jmﬁ]\;l (8.3 x11.7 (cassette 2)
Legal (8.5 x 14 inches 50 sheets (cassette 2) 30 sheets
[216 x 356 mm]) (cassette 2)
Epson Bright Letter (8.5 x 11 inches 80 sheets (cassette 2) 30 sheets

(cassette 2)

Epson Premium |Letter (8.5 x 11 inches
Presentation [216 x 279 mm]) and A4 (8.3 x 11.7
Paper Matte inches [210 x 297 mm])
Double-sided

50 sheets (cassette 2)

1 sheet
(cassette 2)

You cannot print double-sided on these paper types:

Epson Photo Paper Glossy

Epson Premium Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss
Epson Ultra Premium Photo Paper Glossy
Epson Premium Presentation Paper Matte
Epson Iron-on Cool Peel Transfer paper
Epson Ultra Premium Photo Paper Luster
Epson Premium Photo Paper Semi-gloss
Epson Presentation Paper Matte

Epson Ultra Premium Presentation Paper Matte
Epson Photo Quality Self-adhesive Sheets
Epson Iron-on Cool Peel Transfer paper
Envelopes
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Parent topic: Loading Paper

Related references
Paper Loading Capacity

Available Epson Papers

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales) or
epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find
the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Paper Type Size Part number Sheet count
Epson Bright White Pro Paper Letter (8.5 x 11 inches S041586 500
[216 x 279 mm])
Epson Photo Paper Glossy 4 x 6inches (102 x 152 mm) | S041809 50
S042038 100
Letter (8.5 x 11 inches S041141 20
[216 x 279 mm]) S041649 50
S041271 100
Epson Premium Photo Paper 4 x 6inches (102 x 152 mm) | S041808 40
Glossy S041727 100
5x 7inches (127 x 178 mm) | S041464 20
8 x 10 inches (203 x 254 mm) |S041465 20
Letter (8.5 x 11 inches S042183 25
[216 x 279 mm]) S041667 50
Epson Ultra Premium Photo Paper |4 x 6 inches (102 x 152 mm) | S042181 60
Glossy S042174 100
5x 7 inches (127 x 178 mm) | S041945 20
8 x 10 inches (203 x 254 mm) | S041946 20
Letter (8.5 x 11 inches S042182 25
[216 x 279 mmy) S042175 50
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Paper Type

Size

Part number

Sheet count

paper

[216 x 279 mm])

Epson Ultra Premium Photo Paper | Letter (8.5 x 11 inches S041405 50
Luster [216 x 279 mm])
Epson Premium Photo Paper 4 x 6 inches (102 x 152 mm) | S041982 40
Semi-gloss Letter (8.5 x 11 inches S041331 20
[216 x 279 mm])
Epson Presentation Paper Matte | Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Legal (8.5 x 14 inches S041067 100
[216 x 356 mm])
Epson Premium Presentation 8 x 10 inches (203 x 254 mm) | S041467 50
Paper Matte Letter (8.5 x 11 inches S041257 50
[216 > 279 mm]) 5042180 100
Epson Premium Presentation Letter (8.5 x 11 inches S041568 50
Paper Matte Double-sided [216 x 279 mm])
Epson Ultra Premium Presentation | Letter (8.5 x 11 inches S041341 50
Paper Matte [216 x 279 mm])
Epson Brochure & Flyer Paper Letter (8.5 x 11 inches S042384 150
Matte Double-sided [216 x 279 mm])
Epson Photo Quality Self-adhesive | A4 (8.3 x 11.7 inches S041106 10
Sheets [210 x 297 mm])
Epson Iron-on Cool Peel Transfer |Letter (8.5 % 11 inches S041153 10

Parent topic: Loading Paper

Borderless Paper Type Compatibility

You can print borderless photos on compatible paper types in compatible sizes:

Borderless Paper Types
» Epson Photo Paper Glossy

* Epson Premium Photo Paper Glossy
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* Epson Ultra Premium Photo Paper Glossy

* Epson Premium Photo Paper Semi-gloss

* Epson Ultra Premium Photo Paper Luster

» Epson Presentation Paper Matte

* Epson Premium Presentation Paper Matte

* Epson Premium Presentation Paper Matte Double-sided

Borderless Paper Sizes

+ 3.5 x5 inches (89 x 127 mm)

* 4 x6inches (102 x 152 mm)

* 5x7inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

Letter (8.5 x 11 inches [216 x 279 mm])
* A4 (8.3 x 11.7 inches [210 x 297 mm])
Parent topic: Loading Paper

Related references
Printable Area Specifications

Selecting the Paper Settings for Each Source - Control Panel

You can change the default paper size and paper type for each source using the control panel on the
product.

1. Press the 9 home button, if necessary.
2. Select Settings.

86



7.
8.
9.
10.
11.

You see a screen like this:

Supply Stabyus
'i; [ Basic Settings | @
Prinfer Sattings

Meteork Setlings

Select Printer Settings.
Select Paper Source Setting.

Note: To turn off the automatic display of the paper settings selection screen after paper is loaded in
the cassettes, set the Paper Configuration setting to Off. You will be unable to print over AirPrint if
you disable this setting.

Select Paper Setup.
Select the paper source you want to change.

Note: You can quickly save and load combinations of paper size and type as presets. To save a new
preset, select Favorite Paper Settings, select > next to one of the saved presets, and select the
paper size and type that you want to save.

Select Paper Size.
Select the paper size you loaded.
Select Paper Type.

Select the paper type you loaded.
Press @ to select another paper source to change, or press the 41> home button to exit.

Paper or Media Type Settings - Control Panel
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Parent topic: Loading Paper

Paper or Media Type Settings - Control Panel

For this paper Select this Paper Type setting
Plain paper Plain Paper
Copier paper

Epson Bright White Pro Paper
Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Epson Ultra Premium Photo Paper Glossy Ultra Glossy

Epson Premium Photo Paper Glossy Prem. Glossy

Epson Photo Paper Glossy Glossy

Epson Presentation Paper Matte Presentation Matte
Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss

Epson Ultra Premium Photo Paper Luster Ultra Prem. Photo Luster
Epson Premium Presentation Paper Matte Prem. Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided

Envelopes Envelope

Parent topic: Selecting the Paper Settings for Each Source - Control Panel
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Paper or Media Type Settings - Printer Software

For this paper Select this paper Type or Media Type setting

Plain paper Plain Paper/Bright White Paper
Epson Bright White Pro Paper

Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Epson Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Glossy Premium Photo Paper Glossy
Epson Photo Paper Glossy Photo Paper Glossy

Epson Presentation Paper Matte Presentation Paper Matte

Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
Epson Ultra Premium Photo Paper Luster Ultra Premium Photo Paper Luster
Epson Premium Presentation Paper Matte Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided

Envelopes Envelope

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper
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Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damagingit.

Placing Originals on the Scanner Glass

Placing Originals on the Scanner Glass

You can place originals up to this size on the scanner glass: Letter (8.5 x 11 inches [216 x 279 mm]) or
A4 (8.3 x 11.7 inches [210 x 297 mm]).

1. Open the document cover.

2. Clean any dust or stains from the scanner glass surface by wiping it with a soft, dry cloth.

Note: If there is dust or stains on the glass, the scan area may extend to include the dust or stains.
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3. Do one of the following to place your originals:

+ Single sheet: Place your original facedown on the scanner glass with the top facing into the
corner. Slide the original to the edges of the indicated corner.

N |

* Multiple photos for copying: You can place multiple photos of different sizes on the scanner
glass to make separate copies. Make sure your photos are at least 0.2 inch (5 mm) away from
each other and from the corner of the scanner glass. You can place photos up to this size: 4 x 6
inches (102 x 152 mm).

N

* Multiple photos for scanning: You can place multiple photos of different sizes on the scanner
glass and save them separately using Epson ScanSmart. Make sure your photos are at least 0.6
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inch x 0.6 inch (15 x 15 mm) in size, and placed away from each other and the corner mark by at
least the distances shown.

—Nl—

1 0.2inch (4.5 mm)
2 0.8inch (20 mm)
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* ID card: Place an ID card 0.2 inch (5 mm) away from the corner of the scanner glass as shown.

\ / o\ /

________________

4. Close the document cover gently to keep your original in place.

Caution: Do not push down on the document cover or scanner glass or you may damage the
product.

Note: When placing bulky originals such as books, prevent external light from shining directly onto
the scanner glass.

Remove your originals after scanning. If you leave the originals on the scanner glass for a long time, they
may stick to the glass surface.

Parent topic: Placing Originals on the Product

Related tasks
Scanning in Epson Scan 2

Related topics
Selecting Epson ScanSmart Settings
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Copying

See the information here to copy documents or photos using your product.
Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos

Restoring Photos While Copying

Copying Books, ID Cards, or Borderless Photos
Copying Options

Copying Documents or Photos

You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.

1. Place your original document or photo on the scanner glass.
2. Load the paper you want to print on.
3. Press the 900 home button, if necessary.
4. Select Copy.
You see a screen like this:

Q 0 1-1-Sided

@ TIIIIL
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5. To print more than one copy, select Copies and use the displayed keypad to enter the number of
copies.

Change any of the displayed settings as necessary.
Select Advanced Settings to view and change additional copy settings, if necessary.
Select Preview to preview your copy on the LCD screen.

© o N o

When you are ready to copy, select Start Copy or press the Copy icon.
Note: To cancel printing, select Cancel.

Parent topic: Copying
Related references
Copying Options
Available Epson Papers

Related topics
Loading Paper
Placing Originals on the Product

Restoring Photos While Copying
You can restore the colors in faded photos as you copy them.
1. Load the paper you want to print on.
2. Press the fi* home icon, if necessary.
3. Select Various Prints.
4. Select Various copies.
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You see a screen like this:

3 VaARGUS CODias

By Copy/Resiore Pholos

£y M cad ©

Book Copy

! Borderless Copy

Select Copy/Restore Photos.
Make sure the Restore Color setting is set to On.
Select your other paper and print settings as necessary, then select To Placing Originals.

® N o o

Place your original photos on the scanner glass. Make sure they are at least 0.2 in (5 mm) away
from each other and the edge of the scanner glass.

©

Select Start Scanning.
Your originals are scanned and a preview with restored colors appears on the LCD screen.
10. If you need to edit the copy, select Edit and change any of these settings as necessary:

* Photo Adjustments: Select Fix Photo On to improve the color, contrast, and sharpness of
flawed photos.

* Filter: Select B&W to apply a monochrome filter.
* Crop/Zoom: Zoom in to enlarge a part of the photo and crop it.

11. To print more than one copy, select photo(s) and use the displayed numeric keypad to select the
number of copies (up to 99).

12. When you are ready to copy, press the Copy icon.
Note: To cancel printing, select Cancel.

Parent topic: Copying
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Related references
Copying Options
Available Epson Papers

Related topics
Loading Paper
Placing Originals on the Product

Copying Books, ID Cards, or Borderless Photos

You can copy two pages of a book or both sides of an ID card onto a single sheet of paper. You can also
copy a photo and print it without any borders.

1. Load the paper you want to print on.
2. Press the 90 home icon, if necessary.
3. Select Various Prints.
4. Select Various copies.

You see a screen like this:

e VARGUS DOPias

Ba Copy/Resiore Pholos

{If\l_\ B8 D cCand @

Book Copy

E Borderless Copy

5. Select one of these options:
* ID Card: Scan and copy both sides of an ID card onto one side of the paper.
+ Book Copy: Copy two facing pages of a book onto a single sheet of paper.
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Note: Make sure the first page of your original is placed on the scanner glass as described on the
LCD screen and select Print Settings to view and change the print settings, if necessary.

* Borderless Copy: Copy a photo with borders and remove the borders from the copy.
Place your book, card, or photo on the scanner glass.

To print more than one copy, select Copies and use the displayed numeric keypad to select the
number of copies (up to 99).

8. Change any of the displayed settings as necessary.

9. Select Advanced Settings to view and change additional copy settings, if necessary.
10. Select Preview to preview your copy on the LCD screen.

11. When you are ready to copy, select Start Copy or press the Copy icon.

Note: To cancel copying, select Cancel.

12. For ID Card and Book Copy, follow any on-screen instructions to place the rest of your originals and
select Start Scanning.

Parent topic: Copying
Related references
Copying Options
Available Epson Papers

Related topics
Loading Paper
Placing Originals on the Product

Copying Options

Select the copying options you want to use for your copies.
Note: Not all options or settings may be available, depending on other copying settings.

Copy

Copying option |Available settings |Description

B&W — Copies the document in black and white
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Copying option

Available settings

Description

Color — Copies the document in color
2-Sided 1>1-Sided Select to make 2-sided copies. When you select 1>2-Sided,
1>2-Sided also select the Advanced Settings tab to select the

orientation and binding edge for your originals or copies.

Density selector

Varying levels

Adjusts the lightness or darkness of copies

Advanced Settings

Copying option

Available settings

Description

Reduce/Enlarge

Actual Size

Copies the original at its full size

Auto Fit Page

Automatically sizes the image to fit the paper size you
selected

45%->195% and
other conversions

Automatically converts from one size to another

Paper Setting Cassette 1 Displays the currently selected paper size and type. You can
select the paper source to use and adjust the paper size and
Cassette 2 type for each source.
Rear Paper Feed
Slot
Multi-Page Single Page Copies each page of the original onto an individual sheet
2-up Copies multiple page documents onto one sheet. Scroll
down and select the document orientation and layout order
settings as necessary.
Quality Draft Adjusts the quality of your copies
Standard
High
Best
Remove Off Removes or lightens the background color. May not remove
Background very dark or vivid colors.
On
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Copying option

Available settings

Description

Expansion Standard Adjusts the amount to expand the original photo when
Medium copying borderless photos.
Minimum
Clear All Yes Restores all copy settings to product defaults.
Settings No

Parent topic: Copying
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Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows

Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac

Printing with Epson Photo+

Cancelling Printing Using a Product Button

Printing with Windows

You can print with your product using any Windows application, as described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows

Selecting Extended Settings - Windows

Printing Your Document - Windows

Selecting Default Print Settings - Windows

Changing Automatic Update Options

Parent topic: Printing from a Computer
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Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

# Printing Preferences b
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Colr O comar Wk Granyieate

I-Sided Prinking  OH

Sertegl.,
-~ _& Multi-Page off
—I I @ @ i - 1B collete
— L 1B Rorverse Order
e
gt bods o
Chiper SRENGE Prinit Previe
o Arranger Lite
Ristone Defsalts Tnk Livis:
oK Cangel Hulp

102



11.
12.

13.
14.
15.
16.

For the Paper Source setting, select where you loaded the paper you want to print on.
Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

If you are printing a borderless photo, select Borderless. You can click Settings to access
additional options for borderless printing.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

Select the orientation of your document.
Note: If you are printing an envelope, select Landscape.
Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Select the Quality setting that matches the print quality you want to use.

. Select a Color option:

» To print a color document or photo, select the Color setting.
» To print text and graphics in black or shades of gray, select the Black/Grayscale setting.
To print on both sides of the paper, select a 2-Sided Printing option.

To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

To print multiple copies and arrange their print order, select the Copies options.
To reduce noise during printing, turn on Quiet Mode (printing will be slower).
To preview your job before printing, select Print Preview.

To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

Paper Source Options - Windows
Print Quality Options - Windows
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Multi-Page Printing Options - Windows
Parent topic: Printing with Windows
Related references

Double-sided Printing Capacity
Borderless Paper Type Compatibility

Paper Source Options - Windows

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Cassette Selection
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Cassette 1 > Cassette 2
Selects the paper in cassette 1 as the paper source and automatically switches to cassette 2 when
cassette 1 is empty.

Rear Paper Feed Slot
Selects the paper in the rear paper feed slot as the paper source.

CD/DVD Tray
Selects the CD or DVD loaded in the CD/DVD tray.

Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on plain paper.

Standard
For everyday text and image printing.

High
For photos and graphics with high print quality.
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Best
For the best print quality, but the slowest print speed.

Parent topic: Selecting Basic Print Settings - Windows
Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

2-Up and 4-Up
Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2-Up, 4-Up, 6-Up, 8-Up, 9-Up, and 16-Up
Prints several pages on one sheet of paper. Click the Layout Order button to select page layout and
border options.

2x1 Poster, 2x2 Poster, 3x3 Poster, 4x4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

2-Sided Printing  OfF w

Setftings...

1. Select one of the following options for 2-Sided Printing:

+ Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper
on the long edge.

+ Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper
on the short edge.
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* Manual (Long-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the long edge to print the other side (recommended for
paper types that do not support automatic duplexing).

* Manual (Short-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the short edge to print the other side (recommended for
paper types that do not support automatic duplexing).

Click the Settings button.
You see this window:

Binding Settings

Binding Edge
o ' ~Top — Right
Long-edge " Short-edge ' Long-edge

Binding Margin

Front Page 0.00 = [0.00...1.18]

Unit I mm Q) inch

OK ‘ Cancel Help

Select the double-sided printing options you want to use.
Click OK to return to the Main tab.
Click the Print Density button.

106



You see this window:

Print Density Adjustment
Select Document Type
O Tex () Teat with Photo ") Photo ) Manual
Adjustrents
Frint Densaty ] ] (%)
=50 L]
Increase Ink Drying Time ] 0 (se)
0 &0
0K | Cancel Help

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.

8. Click OK to return to the Main tab.

9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows
Print Density Adjustments - Windows

Parent topic: Printing with Windows

Related references
Double-sided Printing Capacity

Double-sided Printing Options - Windows

You can select any of the available options on the Binding Settings window to set up your double-sided
print job.
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Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.
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1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:

» Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your
document or photo as the Document Size setting, and the size of your paper as the Output Paper
setting. If you want to center your image on the paper, select the Center option.

+ Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.
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2. Select one of the following Color Correction options:

+ Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation
for your image.

» Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

+ Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:
+ Watermark: adds a visible watermark to your printout
» Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.

Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows

Parent topic: Printing with Windows
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Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors
for your print job.
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Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

111



ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.
Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Fix Red-Eye
Reduces or removes red-eye in photos.

Print Text in Black
Prints colored text in black.

For Color Text
Prints colored text on a background pattern or underlined.

For Color Graphs and Images
Prints colored graphics and images with overlay patterns.

For Color Text, Graphs, and Images
Prints colored text, graphics, and images with overlay patterns.

Enhancement Options
Specifies Color Universal Print enhancement settings for text, graphics, and images.
Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.
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Bidirectional Printing
Prints in both directions (right-to-left and left-to-right), speeding up printing, but may reduce print
quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the

page.
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Note: These settings are not saved with your document.

Header/Footer Settings
Top Left Top Center Top Right
User Name o Hone e Date/Time o
Bottom Left Bottom Center Bottom Right
Hone o Hone e Hong o
Color M Glack
Fant Arial
Size 11 = pt [6 .. 72]
Style Bold
Iralic
Reset Defaults 0% Cancel Help

You can select to print the following information:
* User Name

» Computer Name

+ Date

* Date/Time

» Collate Number (copy number)

» Page Number
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» Text
You can also adjust the text settings for the printed information.

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

Printing Presets
Add/Remove Presets...

= Document - Fast
=| pocument - Standard Quality
= pocument - High Quality
Document - 2-Sided
B rhoto - 4 x 6 in Portrait
= Photo - 4 % 6 in Landscape
(=) Printable CO/OVD Printing
& rhoto - 8 x 10 in Portrait
= Photo - 8 x 10 in Landscape

i

2. Place your cursor over one of the Printing Presets to view its list of settings.

3. Click on a preset to change its settings or delete it, or use any of the available options on the screen
to control your printing presets.

4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.
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1. Access the Windows Desktop and right-click the 3"-‘ icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click !l.-‘

2. Select Printer Settings.
3. Click the Maintenance tab.
You see the maintenance options:
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4. Click the Extended Settings button.
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You see this window:
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5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows
Extended Settings - Windows
You can select these settings on the Extended Settings window.

Show Progress Meter
Displays the progress of print jobs as they are being printed.

Enable EPSON Status Monitor 3
Enables product monitoring for ink and paper supplies and other issues.

Check Paper Width Before Printing
Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print
speed.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Separator Page
Before each document, prints a separator page containing the title, user, date, and time.
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Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Reduce Print Data Size
Increases print data compression to improve print speed. Not recommended when printing fine
patterns.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:
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2. Click OK or Print to start printing.

Checking Print Status - Windows

Parent topic: Printing with Windows
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Checking Print Status - Windows

During printing, you see this window showing the progress of your print job. It allows you to control
printing and check ink cartridge status.

‘B erson -

EPSON ... ... N

Paper Type & Flan Paper [/ Bright White Faper
Paper Sime ¢ Lether (B.5x 11in)

Pring Quasue Cancsl Buy Epson Ink

» To cancel printing, click Cancel.

» To see print jobs waiting to print, click Print Queue.
» To check ink status, click Consumables Status.
Parent topic: Printing Your Document - Windows

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Access the Windows Desktop and right-click the 51-;‘ icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click -+ )
2. Select Printer Settings.
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You see the printer settings window:

@ Printing Preferences #

Man  More Optons  Manlinance

Printing Presets Fapet Source Ay CEEgatty SpleCiges
AddiRemeg Fresets... Docwment Sine  LESE (5.5 % 11 A)
5 pocument - Fast Borderiess
= Document - Standard Qualty Ot OFormras () Lot pcaes
M Document - Hgh Gualty
£l Dodumant « 2ofuled Paper Type Flain Paper | Bright Whits Paper

B Phots - 4 56 n Pomrea
o Photo - 4 006 in Landscape Cualiy Sapewiand
Prinkable COIVD Frinting

B Photo - 8 x 10 in Portras
o Phato - § % 10 in Landscape

Colr O Comor ik Grayicels

I-Gided Frinting  ONY

Settingl.,
-~ _é Mult-Fage ol
_| 1 @ p i - 1B Collate
— e 1B rorverse Order
L
Cpuset B o
Shrr SHENGS Print Previr
Job Aranger Lite
Furstone Defsaits ik Ll
e Cancel Halp

3. Select the print settings you want to use as defaults in all your Windows programs.

4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows
Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the ﬁ; icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click £,
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2. Select Printer Settings.

You see the printer settings window.
3. Click the Maintenance tab.

You see the maintenance options:

& Printing Preferences .

Man  More Optans Rlamsngng g

E Print Head Norrbe Check E—‘ EFS0 Status Montor 3

3\: Frint Head Cheaning Ej Mantoring Preferences

% Extendid Semngs

) o
@j Job Arranger Lite
& Ranguoge S Softevare Update
s (Enaen : Onling Order
wnion 100000, 00
Ol Suppiet
oK Cangel Hulp

4. Select the language you want to use as the Language setting.

5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows
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Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the & icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Software Update Settings.
You see this window:

Software Update Settings X

Check for Software Updates on the Internet

(®) Check every 2 wesks

I,_ Mewer

carcs

3. Do one of the following:

» To change how often the software checks for updates, select a setting in the Check every menu.
» To disable the automatic update feature, select the Never option.
4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.
Parent topic: Printing with Windows

Printing with the Built-in Epson Driver - Windows 10 S

You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as
described in these sections.
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Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your
product. To print with additional settings, download and install the Epson Print and Scan utility from the
Windows Store. You cannot download and install any Epson product software from the Epson website
for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S
Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see a window like this:

% Epson ESC/P-R VA Class Driver Printing Preferences A
Layoud  Papes/Cusity
Tray Sedection
Advanced...
Concel | [ ooty

Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Click the Advanced button.
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You see a window like this:

Epson ESC/P-R V4 Class Driver Advanced Options H

me Epson ESC/P-R V4 Class Driver Advanced Document Settings
=11 Paper/Qutput

Paper Size: Lether

Copy Count: || = Collated

Select the size of the paper you loaded as the Paper Size setting.

To print multiple copies, select or enter the number as the Copy Count setting.

To print multiple copies of multi-page documents in sets, select the Collated checkbox.
Click OK.

You return to the printing preferences window.
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10. Select the Layout tab.

i Epson ESC/P-R VA Class Diiver Printing Preferences b

Layout  Pages/Chulty

Crientation:

(B oot

Prant on Both Sedes:
4 Mone V]

[0

Advanced_..

I =T

11. Select the orientation of your document as the Orientation setting.
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12. To print double-sided, select one of the Print on Both Sides options, depending on how you want to
orient the page layout. The icon next to each option shows the layout.

" Epson ESC/P-R VY Class Dirvwer F'nn-.mg Preferences oo
Lavoul  Paper/Clualty
Orientation:
(%] Partrait

Prant on Both Sedes:
A Mone w

EF Flip on Long Edge
§ Fip on Short Edge

Advanced_..

[ ok ][ conce

13. Click OK to save your settings.
You see your application's Print window.
14. Click OK or Print to start printing.
Parent topic: Printing with the Built-in Epson Driver - Windows 10 S

Printing on a Mac

You can print with your product using any Mac printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
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Selecting Print Layout Options - Mac

Selecting Double-sided Printing Settings - Mac
Managing Color - Mac

Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Mac
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: EPSON &

Presets: Default Settings &

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printer: EPSOM E
Presets:  Default Settings E
Copies: |1 |
Pages: © Al
Fram: 1 w1
Paper Size:  US Letter 8.50 by 11.00 inches ]

Orientation: © +Z Portrait 1 Landscape

Proview E
Auto Rotate
O Scale: 1005
Secala to Fit:
Copies per page: 1 B
PoF @ cancel  (EEIND

Note: The print window may look different, depending on your version of the Mac operating system
and the application you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.

Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.
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7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings or Printer Features from the pop-up menu.

v Preview

Layout

Color Matching
Paper Handling
Cover Page

Color Options
Two-sided Printing Settings

Supply Levels
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You see these settings:

Print Settings & ]
Paper Source!  Cassatte 2 8
Media Type:  Plain Paper [ Bright White Paper (<]
Print Quality: Mormal (]
Barderless
-
Grayscale
HEAT: FaLK | Mirrar Image
roF @ cancel (D

Note: The available print settings and appearance of the print window may be different than those
covered here, depending on the Mac OS version and the application you are using.

9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.

12. Select the Borderless checkbox if you want to print a borderless photo. If the option is grayed out,
change the Media Type setting to a paper type that supports borderless printing.

13. Select any of the other available print options.

Paper Source Options - Mac
Print Quality Settings - Mac
Print Options - Mac

Parent topic: Printing on a Mac
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Paper Source Options - Mac

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Select
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Mac
Print Quality Settings - Mac

You can select any of the Print Quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on photo paper.

Economy
For fast printing with reduced quality.

Normal
For everyday text and image printing.

Fine
For text and graphics with good quality and print speed.

Quality
For photos and graphics with good quality and print speed.

Best Quality
For the best print quality, but the slowest print speed.

Parent topic: Selecting Basic Print Settings - Mac
Print Options - Mac

You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
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Expansion
If you selected a borderless paper size setting, this option adjusts the image expansion settings to
control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed
photo.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: US Letter 8.50 by 11.00 inches B

Orientation: © +[z) Portrait 14 Landscape

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select the Borderless checkbox or a paper size with a Borderless option. You can also
select a custom setting to create a custom paper size.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the "= icon.
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Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing on a Mac

Related references
Borderless Paper Type Compatibility

Selecting Print Layout Options - Mac

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

Layout il

Pages per Sheet: 1 ﬂ
Layout Direction: ,_'_ : HH Fhd

Border: Mone d

Sided:

Reverse page orientation
Flip harizontally

Cancel | LU

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.

» To print on both sides of each page, select a setting from the Two-Sided pop-up menu.

» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing on a Mac
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Selecting Double-sided Printing Settings - Mac

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Two-sided Printing Settings B

Two-sided Printing:  Off E

roF @ cancel (D

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the Mac
OS version you are using.

1. Select one of the Two-sided Printing options.
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2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

Two-sided Printing Settings &)

Two-sided Printing: Long-Edge binding B
Document Type:  Text B
Adjustenents:
Print Dengity:
L
-50 o
Ingreased ink Deying Timg
0 (sec)
] +60

When printing 2 phote or Sacument containing a Bt of sclid image
areas, reduce the density of the ink and increase its drying time,

FoF @ Cancel (TN

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options and Adjustments - Mac

Parent topic: Printing on a Mac

Related references
Double-sided Printing Capacity

Double-sided Printing Options and Adjustments - Mac

You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.

138



Two-sided Printing Options

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.
Adjustments

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac

Managing Color - Mac

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout or
turn off color management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

Color Matching &

ColorSyne © EPSON Color Controls

2. Select one of the available options.
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3. Select Color Options from the pop-up menu in the print window.

Calor Options B

O Manual Seitings
Fix Phaoto
Off (Mo Color Adjustment)

Advanced Sottings

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - Mac
Parent topic: Printing on a Mac

Color Matching and Color Options - Mac

You can select these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls
Lets you manage color using controls in your printer driver or turn off color management.

ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

Color Options Settings

Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
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Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.
Parent topic: Managing Color - Mac

Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
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You see a screen like this:

AU N d Lo

Establizh Edinectional commnication

Thick paper and enicpes:
Skip Blank Page:

Culot Mode:

Pormit tempocany black printing:
Autemates Caiite Switching:
Bidirectional printing:

Warning Motifications:

Reduce Pried Data Size:

General Options  Supply Levels

o
o

Uitility

To taky full sdhvaniege of your peintar's opisong, conlum that they ane scciuraialy shown
Feisil, Fod indaamalicn o your peintar and it aplionad handwans, chack tha peinter s

CoooCc@oOoO@

Cancel

4. Select any of the available printing preferences.

5. Click OK.

Printing Preferences - Mac

Parent topic: Printing on a Mac
Printing Preferences - Mac

You can select these settings on the Options or Driver tab.

Thick Paper and Envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page

Ensures that your product does not print pages that contain no text or images.

Quiet Mode

Lessens noise during printing but may decrease print speed.

Permit temporary black printing

Allows you to print using black ink when color ink is expended.
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Automatic Cassette Switching
Automatically switches to the other cassette when one of the cassettes runs out of paper.

Bidirectional printing
Prints in both directions (right-to-left and left-to-right), speeding up printing, but may reduce print

quality.
Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various

operating conditions.
Establish bidirectional communication

Allows the product to communicate with the computer. Do not change the default setting unless you

experience issues when using a shared printing pool.

Reduce Print Data Size
Increases print data compression to improve print speed. Not recommended when printing fine

patterns.
Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.

Click Print at the bottom of the print window.

Print Settings (5]

Paper Source:  Cassette 2 B
Plain Paper | Bright White Paper

hedia Type:
Print Quality: Mormal

Borderless

b
Grayscale
Mirrar Image

Cancel m

FOF 3
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Checking Print Status - Mac
Parent topic: Printing on a Mac
Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
You see the print status window:

& @ FPSGN o

mach2_driver_oplions_iabpng

2. Select the following options as necessary for your Mac OS version:
* To cancel printing, click the print job and click I:l or Delete.

» To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document or Photo - Mac

Printing with Epson Photo+

You can print photos, CD/DVD labels, and more using a variety of layouts and templates with Epson
Photo+. Features include image corrections and adjustments, and adding text and stamps to photos. We
recommend printing on genuine Epson photo paper for the best results. Make sure you have set up your
product as described on the Start Here sheet and installed the Epson Photo+ software. See the Epson
Photo+ help utility for more information.
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Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use
Epson Photo+. You also cannot download and install any Epson product software from the Epson
website for use with Windows 10 S; you must obtain software only from the Windows Store.

Parent topic: Printing from a Computer

Cancelling Printing Using a Product Button
If you need to cancel printing, select Cancel on the LCD screen.
Parent topic: Printing from a Computer
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Scanning

You can scan your originals and save them as digital files.

Starting a Scan

Scanning a Document in Epson ScanSmart
Selecting Epson ScanSmart Settings
Scanning in Epson Scan 2

Starting a Scan

After placing your originals on your product for scanning, start scanning using one of these methods.

Starting a Scan Using the Product Control Panel
Starting a Scan Using Epson ScanSmart
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smartphone or Tablet

Parent topic: Scanning

Starting a Scan Using the Product Control Panel
You can scan an image to a variety of destinations using your product's control panel.

1. Make sure you installed the product software and connected the product to your computer or
network.

Note: Restart your computer after installing the product software to enable scanning from the control
panel.

Place your original on the product for scanning.
Press the 90t home button, if necessary.
4. Select Scan.
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You see a screen like this:

5. Select one of the following Scan to options:

* Memory Device saves your scan file on a USB device or memory card and lets you select the file
format, quality, and other settings.

+ Computer lets you scan to a connected computer using your saved scan settings.
» Cloud sends your scanned files to a destination that you have registered with Epson Connect.

» WSD lets you manage network scanning in Windows 11, Windows 10, Windows 8.x, Windows 7,
or Windows Vista (English only). To use this feature, you must first set up a WSD (Web Services
for Devices) port on your Windows 7 or Windows Vista computer (the port is set up automatically
on Windows 11, Windows 10, and Windows 8.x).

6. Follow the instructions in the links below to complete your scan.

Scanning to a Memory Device

Scanning to a Connected Computer

Scanning to the Cloud

Setting Up a WSD Port (Windows 7/Windows Vista)
Control Panel Scanning Options

Changing Default Scan Job Settings

Parent topic: Starting a Scan
Scanning to a Memory Device
You can scan an original and save the scanned image to a memory card or external USB device.
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1. Insert a memory card into your product's memory card slot or connect an external USB device to the
port on the front of the product.

2. Place your original on the product for scanning.
Press the 92 home button, if necessary.

4. Select Scan.
You see a screen like this:

Kooy

Device Comguiin

5. Select Memory Device.
You see a screen like this:

F il Spaca

0 B
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If prompted, select a device.
Change any of the displayed settings on the Scan tab as necessary.
Select the Advanced Settings tab to view and change additional scan settings, if necessary.

© o N o

On the Scan tab, press the Save icon to start scanning.
Your product scans your original and saves the scanned file to the memory card or USB device.
Parent topic: Starting a Scan Using the Product Control Panel

Related tasks
Inserting a Memory Card
Connecting and Using a USB Flash Drive or External Device

Scanning to a Connected Computer

You can scan an original and save it to a connected computer using your product's control panel. The
computer must be connected using a USB cable or connected to the same network as your product.

You can save the scanned file as a JPEG or PDF file, or attach it to an email. You can also set up
custom scan settings using Event Manager and automatically scan using those settings on your product
control panel.

Note: Be sure you have installed Epson Scan 2, Epson ScanSmart, and Event Manager on your
computer before scanning to your computer.

1. Place your original on the product for scanning.
2. Press the 7 home button, if necessary.
3. Select Scan.
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You see a screen like this:

Mhormgry ,
Davice Comgutor

4. Select Computer.
5. Select OK to close the information screen, if necessary.
6. Select Select a computer.

You see a screen like this:

@ Scan o Compuier

@ LISB Connection

A

9 Save as PDF

7. Do one of the following:

* If your computer is connected to your product over a network, select a connected computer from
the displayed list. (If your computer is not listed, select Search Again.)
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* If your computer is connected to your product using a USB cable, select USB Connection.
8. Select Save as PDF and choose one of the following options:

» Save as JPEG to save the scanned scanned image as a JPEG file.

+ Save as PDF to save the scanned document or image as a PDF file.

» Attach to email to open the default email software on your computer and save the scanned
document or images as a JPEG email attachment.

* Follow custom setting to save the scanned document or image using custom settings you have
selected using the Event Manager custom scan settings option.

Note: You can customize the settings for each of the options above using Event Manager.

9. Select Save to start scanning.
Parent topic: Starting a Scan Using the Product Control Panel

Related tasks
Changing Default Scan Job Settings

Related topics
Placing Originals on the Product

Scanning to the Cloud

You can use the control panel to send your scanned files to a destination that you have registered with
Epson Connect.

Note: Make sure to set up your product using Epson Connect before using this feature.

1. Place your original on the product for scanning.
2. Press the 0 home button, if necessary.
3. Select Scan.
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You see a screen like this:

Momery ;
Dovice Comgutor

4. Select Cloud.
You see a screen like this:

@ [Se:n:w:l Destination. .ﬂ

Note: You must register your product with Epson Connect to select a destination.

Select Select Destination to select a destination.
Change any of the displayed settings on the Scan tab as necessary.
Select the Advanced Settings tab to view and change additional scan settings, if necessary.

© N o o

On the Scan tab, press the Upload icon to start scanning.
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Your product scans your original and saves the scanned file to the selected destination.
Parent topic: Starting a Scan Using the Product Control Panel

Related tasks
Setting Up Epson Connect Services

Related topics
Placing Originals on the Product

Setting Up a WSD Port (Windows 7/Windows Vista)

You can scan to a networked Windows computer using WSD (Web Services for Devices). You must first
set up a WSD port on your Windows 7 or Windows Vista system (the port is set up automatically on
Windows 11, Windows 10 and Windows 8.x).

Before you set up a WSD port, make sure you installed your product software, and connected your
product and computer to the same network.

1. Turn on your product.

2. Print a network status sheet so you can identify the network name and model name for your product
on the network.

Click E" or Start and select Computer.
On the left side of the window, select Network.
Locate your product on the Network screen, right-click it, and select Install.

o a0 bk w

When you see the User Account Control screen, click Continue.
Note: If you see an Uninstall screen, click Uninstall and repeat these steps as necessary.

7. When you see the message Your device is ready to use in the Windows taskbar, click the
message.

8. On the Driver Software Installation screen, make sure your product is listed as Ready to use. Then
click Close.

9. Do one of the following:

* Windows 7: Click E]' and select Devices and Printers.

* Windows Vista: Click Start and select Control Panel > Hardware and Sound > Printers.
10. Make sure that an icon appears for your product's name on the network.
When you use WSD, select your product name to scan over the network.
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Parent topic: Starting a Scan Using the Product Control Panel

Control Panel Scanning Options

Select the options you want to use for scanning.

Note: Not all options or settings may be available, depending on the Scan to option selected.

Scan to setting

Available options

Description

Color Mode Color Select whether to scan images in color or black
B&W and white

File Format JPEG Select for photos.
PDF Select for documents.

Original Type Text Specifies the type of original you are scanning
Photo

Resolution 200dpi Select for documents
300dpi Select for photos
600dpi Select for highest quality printing

Scan Settings Letter Select the page size for documents, then select
Ad the orientation of the original

Auto Cropping

Select for photos with dark edges

Max Area Select for most photos
Portrait Select to match the orientation of the original
Landscape

Contrast —-4to+4 Adjusts the lightness or darkness of scanned

images.

Parent topic: Starting a Scan Using the Product Control Panel

Changing Default Scan Job Settings

You can view or change the default scan job settings your product uses when you scan to your
computer. You do this using the Event Manager program.
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5.
6.
7.

Do one of the following to open Event Manager:

* Windows 11: Click , then search for Event Manager and select it.

* Windows 10: Click I:I and select Epson Software > Event Manager.

* Windows 8.x: Navigate to the Apps screen and select Event Manager.

* Windows (other versions): Click E" or Start > All Programs or Programs > Epson Software >
Event Manager.

» Mac: Open the Applications folder, click Epson Software, and select Event Manager.

Open the Scanner (Windows) or Select Scanner (Mac) drop-down list and select your product, if
necessary.

Click Make Job Settings.

Open the Edit Job Settings drop-down list and select the scan job settings you want to view or
change.

Change the settings as necessary.
Click OK.
Click Close to close the Event Manager window.

Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan Using Epson ScanSmart

You can start the Epson ScanSmart program to scan originals and easily review and edit scanned
images. After that, you can save, print, or share them.

Windows 11: Click , then search for Epson ScanSmart and select it.

Windows 10: Click E > Epson Software > Epson ScanSmart.
Windows 8.x: Navigate to the Apps screen and select Epson ScanSmart.

Windows (other versions): Click E]' or Start, and select All Programs or Programs. Select Epson
Software > Epson ScanSmart.

Mac: Open the Applications folder, open the Epson Software folder, and select Epson ScanSmart.
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You see a screen like this:
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Parent topic: Starting a Scan

Starting a Scan Using the Epson Scan 2 Icon

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

* Windows 11: Click , then search for Event Manager and select it.

* Windows 10: Click E and select EPSON > Epson Scan 2.
* Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.
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* Windows (other versions): Click E]' or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

* Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:

(3 Epson Scan2 - o x
Scanmner : |EF'SEN "’|
Scan Settings : | Default Setting v
Mode : |Du-u.menthlode “’|
Main Settings  Advanced Settings
Document Source : [Scamertshss "|
Document Size : [Lﬂw ""|Ij d | :
Image Type : | Color v
Resolution o
Rotate : | 0° v
Correct Document Skew : | OFf v
[] &dd or edit pages after scanning
Image Format : |p|;¢: V|
File Name : | img20190625_100125%.pdf v]
Folder : | pocuments v
0L R -
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Parent topic: Starting a Scan

Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software

from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; not all scan functions will be available.
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You see an Epson Scan 2 window like this:

Epson Scan 2 =

Scanner : |EPSCN

Scan Settings : | Default Setting

Mode : | Document Mode

Main Settings  Advanced Settings

Dooument Source : [Scamert.’hss

Document Size | [l.etter ~..-|._ .

Image Type : | Color

Resuton: (8 <]

Rotate : | 0°

Correct Document Skew : | OFf

] add or edit pages after scanning

Image Format : |p|;.|=

Fle Name : | img20190625_10012646.pdf

Folder : |Dﬂﬂ-l11ﬂﬂ|‘.‘i

2 MR | revew
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Parent topic: Starting a Scan

Starting a Scan from a Smartphone or Tablet

You can use the Epson Smart Panel app to scan from a network scanner to an iOS or Android device
over a direct Wi-Fi connection.

1. Download the Epson Smart Panel app from your device's app store or from Epson's website. See
the link below.

2. Place your original on the product for scanning.

3. Open the Epson Smart Panel app and select a scan menu on the home screen.
4. Follow the on-screen instructions to scan and save your original.

Parent topic: Starting a Scan

Related tasks
Using the Epson Smart Panel Mobile App

Related topics
Placing Originals on the Product

Scanning a Document in Epson ScanSmart
You can scan and review documents and photos in Epson ScanSmart.

Note: The images in this guide show Windows screens. Mac screens may be slightly different.
Depending on your product model and software version, not all options may be available.

Load your original into the product.
2. Open Epson ScanSmart on your computer. Do one of the following:
* Windows 11: Click , then search for Epson ScanSmart and select it.

* Windows 10: Click E > Epson Software > Epson ScanSmart.

* Windows 8.x: Navigate to the Apps screen and select Epson ScanSmart.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson Software > Epson ScanSmart.

* Mac: Open the Applications folder, open the Epson Software folder, and select Epson
ScanSmart.
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You see a screen like this:
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Select an option for the Scan area setting, if necessary.

Note: The Scan area setting limits the scan area to a selected size starting at the placement arrow
on the scanner bed. It does not scale the image to the selected size.

Select SCAN.
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The original is scanned. When scanning is complete, you see a screen like this:

You can review, edit, or reorder the scanned images as follows:

Select + Scan to scan more originals.

Select Delete to delete selected scanned images.
Select Rotate Right to rotate each scanned image.
Select Crop to crop the selected image.

Control-click two images, select Stitch Images, and follow the on-screen instructions to combine
them into a single image.

If Photo Mode is automatically detected, the following enhancement options are available:

Auto Color Enhancement: automatically adjusts the brightness, contrast, and saturation of your
photos

Restore Faded Colors: restores the colors in faded photos automatically
Remove Red Eye: automatically removes the red-eye effect from your photos
Auto Cropping: automatically crops the scanned image edges

When you finish reviewing and editing the scanned images, click Next.
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You see a screen like this:
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8. Select an option to save, send, or print the scanned images. See the links below.

Saving a Scan

Attaching a Scan to Email

Sending a Scan to a Cloud Service
Printing a Scan

Parent topic: Scanning

Saving a Scan
You can save a scanned image to your computer in a variety of formats.
1. Make sure your originals are scanned and reviewed. See the link below.
2. Inthe Select Action window, click Save.
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You see a screen like this:

3. Change the settings as follows:

» The document type and scan date for the file name are automatically detected. You can change
them as necessary.

* You can save the scanned image in a variety of formats.

» Select the folder on your computer in which to save the file.
4. Click Save.

Parent topic: Scanning a Document in Epson ScanSmart

Attaching a Scan to Email

You can attach a scanned image to an email as a file attachment.

Note: Your email app and account settings should be configured before scanning. You must install a
MAPI-type email program such as Outlook Express, Windows Live Mail, Entourage, or Mac Mail. Attach
to Email only supports 32-bit MAPI-compatible mail apps. Web-based email services such as Gmail are

not supported. If you see an error message, your email app may not be compatible and you will need to
save the scans and manually attach the file to an email.

1. Make sure your originals are scanned and reviewed. See the link below.
2. Inthe Select Action window, click Attach to Email.
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You see a screen like this:

3. Change the settings as follows:

» The document type and scan date for the file name are automatically detected. You can change
them as necessary.

* You can save the scanned image in a variety of formats.

+ If you also want to save a copy of the scanned image to your computer, make sure the checkbox
is selected and select the folder on your computer in which to save the file.

4. Click Attach to E-mail.
Your email program opens with the file attached to a new email.
Parent topic: Scanning a Document in Epson ScanSmart

Sending a Scan to a Cloud Service
You can upload scanned images to a cloud service.
1. Make sure your originals are scanned and reviewed. See the link below.
2. Inthe Select Action window, click one of the cloud service send options.
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You see a screen like this:

3. Login to your account.

Note: You may need to allow Epson ScanSmart access to your account. The first time you log in,
you may be prompted to enter an authentication code.

4. Change the settings as follows:
+ Select the folder in your account where you want to send the document.

» The document type and scan date for the file name are automatically detected. You can change
them as necessary.

* You can save the scanned image in a variety of formats.

 If you also want to save a copy of the scanned image to your computer, click the checkbox.
5. Click Send.
Parent topic: Scanning a Document in Epson ScanSmart

Printing a Scan
You can print your scanned image and save the scanned file to your computer.

Note: Printing scanned images is available only with Epson printers. If you do not have an Epson printer,
save the file and print it from an application that can open the file.
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1. Make sure your originals are scanned and reviewed. See the link below.

2. Inthe Select Action window, click Print.

You see a screen like this:

S Print Semtingt

3. Change the settings as follows:

Select the Epson printer and change the print settings, if necessary.
Select the number of copies you want to print.
If you also want to save a copy of the scanned image to your computer, click the checkbox.

The document type and scan date for the file name are automatically detected. You can change
them as necessary.

You can save the scanned image in a variety of formats.
Select the folder on your computer in which to save the file.

4. Click Print.
Parent topic: Scanning a Document in Epson ScanSmart

Selecting Epson ScanSmart Settings

After starting Epson ScanSmart, you can change various scanning settings.

Changing the Epson Product
Changing the Scan Settings
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Changing the File Name Settings
Changing the Save Settings
Customizing Action Icons

Parent topic: Scanning

Changing the Epson Product
If you are using more than one Epson product with Epson ScanSmart, you can change the product that
you are using with your computer.

Note: A product connected to your computer via USB takes priority over a product with a Wi-Fi
connection.

1. On the main screen, click Change.
You see a screen like this:

B et e £
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2. Select the Epson product you want to use with your computer and click OK.
Parent topic: Selecting Epson ScanSmart Settings
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Changing the Scan Settings

You can change detailed scan settings such as the resolution, document size, and more.

Note: If you select Auto Mode, you cannot change the scan settings.

1. Click the B settings button.
You see a screen like this:
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2. Do one of the following:
» To change Document Mode settings, select Document Mode > Custom Settings.

» To change Photo Mode settings, select Photo Mode and click Close. When you start a scan, you
will be prompted to select scan settings.
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You see a screen like this:

& epson Scan 2 = (m]

Scanner : | EPSON

Scan Settings : | Not Selected

Main Settings  Advanced Settings

Document Source : | Scanner Glass v
Document Size : [l.etter w
Image Type : | Auto v|
Resolution : dpi
Rotate : |02 ~|
Correct Document Skew : | Off v |

Add or edit pages after scanning

ea Preview Save

3. Change the settings as necessary and click Save.
Parent topic: Selecting Epson ScanSmart Settings
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Changing the File Name Settings
You can change the default file naming method for your scans.
1. Click the @ Settings button.
You see a screen like this:
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2. Click the File Name Settings tab.

172



You see a screen like this:
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3. Change the settings as necessary:
» Enter a prefix for the file name.
+ Select the date format.
» Select a numbering format as the counter format.

4. Click Close.
Parent topic: Selecting Epson ScanSmart Settings

Changing the Save Settings

You can change the file type options for saving your scans.

1. Click the B2 settings button.
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You see a screen like this:
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2. Click the Save Settings tab.
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You see a screen like this:
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3. Click Options for a file format and change the settings as necessary.
4. Click Open folder after saving to open the file folder after a file is saved.
5. Click Close.
Save Settings
Parent topic: Selecting Epson ScanSmart Settings
Save Settings
You can change the settings for how scanned images are saved.
PDF Options
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Setting Options Description
General Generate PDF/A File Creates a PDF that conforms to
PDF/A-1 standards
Create file with all pages |Saves all pages as one file
Compression Level Selects the compression level for color
or grayscale images
JPEG Options
Setting Options Description
Image Quality Options — Sets a compression level by moving a
slider or entering a value. File size
increases the higher the resolution is.
Encoding (Windows only) Standard Images load from top to bottom in a

web browser. It takes longer to load the
entire image.

Progressive

Images first load completely at low
resolution and then adjust to high
resolution in a web browser

Embed ICC Profile (Windows
only)

Allows you to add ICC profiles to the
image

TIFF Options

Setting Options Description

Byte Order Windows Specifies the operating system where
Macintosh the scanned image will be used

Compression (Windows only)

Specifies the compression format and
level for Color/Grayscale and B&W
images. File size increases with higher
quality.

Embed ICC Profile (Windows
only)

Allows you to add ICC profiles to the
image
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Parent topic: Changing the Save Settings

Customizing Action Icons
You can customize which scan action icons appear on the Select Action screen.

Note: You can also customize them by clicking the Customize icon on the Select Action screen.

1. Click the B settings button.
You see a screen like this:
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2. Click the Customize Actions tab.
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You see a screen like this:

e *
= foan Eaminge Customize Actions
1? Fragny [
o Ch e
- L e .
L o LE pho
m TR o+ [ Twrret
- B Pr
T| fger Somes - a T e Siros B
gt Har Crage Close

3. Choose which action icons to display by selecting or deselecting each checkbox. Click the arrow
icons to move the icons up or down in the display order you want.

4. Click Close.
Parent topic: Selecting Epson ScanSmart Settings

Scanning in Epson Scan 2

Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document
and save the scanned image in various file formats in your operating system's Documents or My
Documents folder, or open it in your scanning program. You can preview the scanned image and select
or change settings as necessary.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Start Epson Scan 2.
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You see this window:

Epson Scan 2

Scanner : |EPSCN

Scan Settings : | Default Setting

Mode : | Document Mode

Dacument Source :

Document Size @

Image Type :
Riesolution
Rotate :

Correct Document Skew :

Main Settings  Advanced Settings

[SCHIHG'MS

| Letter

[ Color

@

Lo°

| off

[[] &dd or edit pages after scanning

Image Format : |p|;.|=

Fle Name : | img20190625_10012646.pdf

Folder : | pocuments

2 MR
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2. Select the Mode setting that matches the type of original you are scanning.

3. Select the Document Source setting that matches where you placed your original.

4. Select the Document Size setting that matches the size of your original. You can select Customize
to enter a custom size, if necessary.

5. Select the image type of your original and how you want it scanned as the Image Type setting.

6. Select the Resolution setting you want to use for your scan.

7. Select the Rotate setting to rotate the scanned image.

8. Select the Correct Document Skew setting to correct skewed originals, image contents, or both.

9. Click the Preview button.

Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

10. Do one of the following:

* If you're scanning in Document Mode, select any of the additional settings that you want to use on
the Main Settings tab.

+ If you're scanning in Photo Mode, select the Color Management and Thumbnail Options
settings as necessary.

11. Click the Advanced Settings tab and select any settings that you want to use.
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12. Select the format in which you want to save your scanned file as the Image Format setting. If
necessary, select Options and select any desired format options.

13. Enter the file name for your scanned file in the File Name field. If necessary, select Settings to
modify the file name settings.

14. Select the location in which you want to save your scanned file as the Folder setting. If necessary,
select Select to create a new folder.

15. Click Scan.
The product scans your original and saves the scanned file in the location you specified.

Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
Image Format Options

Scan Resolution Guidelines

Parent topic: Scanning

Additional Scanning Settings - Main Settings Tab

You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.

Correct Document Skew
Corrects skewed originals, image contents, or both.

Add or edit pages after scanning
Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.

Parent topic: Scanning in Epson Scan 2

Additional Scanning Settings - Advanced Settings Tab

You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.

Remove Background
Removes the background of the originals.
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Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.

Threshold

Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Saturation
Adjusts the density of colors in the overall image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Corrects color in faded images (when scanning in Photo Mode).

Backlight Correction
Lightens darkly backlit images (when scanning in Photo Mode).

Dust Removal
Removes dust on scanned images (when scanning in Photo Mode).

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.
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Dual Image Output
Scans the original image twice using different output settings (Windows only).

Watermark
Adds a watermark to a scanned image.

Parent topic: Scanning in Epson Scan 2

Image Format Options

You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

BITMAP (*.bmp)
A standard image file format for most Windows programs.

JPEG (*jpg) | | | |
An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines

The Resolution setting, measured in dpi (dots per inch), controls the amount of detail captured in your
scans. Increasing the resolution raises the amount of detail captured but comes with the following
disadvantages:

* Larger file sizes

* It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
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* The image may become too large to fit on your display or print on paper

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the
resolution setting you need:

* You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same
amount you will increase the image size to retain a high image quality. For example, if the resolution is
300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600
dpi.

* You will scan the image at 100% or a smaller size.
Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
» Email/view on a computer screen/post on the web: 96 to 200 dpi
* Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

Parent topic: Scanning in Epson Scan 2
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Using Memory Cards with Your Product
Follow the instructions here to work with a memory card inserted into your product.
Note: Make sure your memory card and the files on it meet the specifications for your product.

Inserting a Memory Card

Printing from a Memory Card

Transferring Photos on a Memory Card
Inserting a Memory Card

Insert a memory card into the memory card slot on your product as described here.
Note: Make sure your memory card and the files on it meet the specifications for your product.

1. Make sure the memory card and the files on it are compatible with your product before inserting the
card.

2. Raise the control panel.
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3. Insert your memory card into the slot, making sure the card is oriented correctly.

Note: Do not force the card all the way into the slot. Insert it only until it meets resistance.

The memory card access light flashes and then stays lit.

Caution: Do not remove a memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.

Removing a Memory Card
Parent topic: Using Memory Cards with Your Product

Related references
Memory Card Specifications

Removing a Memory Card

After you finish working with a memory card, check to make sure it is safe to remove it from your product.

Caution: Do not remove a memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.

186



1. Raise the control panel.

3. If your product is connected to your computer using a USB cable, do one of the following:

* Windows: Open the My Computer, Computer, Windows Explorer, or File Explorer utility.
Then right-click the name of your memory card (listed as a removable disk) and select Eject.

» Mac: Drag the removable disk icon for your memory card from the desktop or computer window
into the trash.

4. Push in the memory card, then pull it straight out of its slot as shown above.
Parent topic: Inserting a Memory Card
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Printing from a Memory Card

See these sections to print photos from a memory card inserted into your product.
Viewing and Printing Photos

Printing Photo Layouts from a Memory Card with a Template

Printing ID Photos from a Memory Card

Creating and Printing a Greeting Card Template

Printing a Greeting Card from a Template

Parent topic: Using Memory Cards with Your Product

Viewing and Printing Photos

See these sections to view and print photos displayed on your product's LCD screen.

Viewing and Printing Photos From the LCD Screen
Memory Card or External USB Device Print Settings

Parent topic: Printing from a Memory Card
Viewing and Printing Photos From the LCD Screen
You can select photos for printing as you view them on the LCD screen.

Note: You can also select Settings > Basic Settings > Screen Saver > Memory Card Data to display
photos on the memory card as a slideshow when the LCD screen is not used for a period of time.

1. Load photo paper in your product.
Insert a memory card into your product's memory card slot.
3. Press the 9r home icon, if necessary.

Note: If Auto Selection Mode is turned on in the Guide Functions menu, select to function index
when you see the information screen.
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4. Select Print Photos.

5. Select Print and select OK.
You see a screen like this:

@ Select Phato

6. Do one of the following to select your photos:

+ Select the thumbnail images of the photos you want to print. Each photo you select has a number
on it to indicate the number of prints you selected.

Note: If you want to print multiple copies of a photo, select Single View and press the + or - button
to adjust the number of prints. Select Tile View to return to the thumbnail image view and select
additional photos.
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» To select all photos or a group of photos, select the = menu icon and select Select All Photos.

Note: The number of prints you select for each photo will be multiplied by the number of copies you
select before printing.

7. If you need to edit a photo, select Single View during photo selection and press the left or right
arrow button to scroll to the photo you want to edit.

You see a screen like this:

e Select Photo =

1  Lets you zoom in and out of the photo.

2  Lets you apply filters, make color and red-eye corrections, and adjust cropping, rotation,
brightness, contrast, sharpness, and saturation if necessary.

Note: Press the Correction On button to switch between Correction Off and Correction On. With
Correction On selected, any corrections you make to a photo are displayed on the screen. With
Correction Off selected, any corrections you make will only be applied to your printouts.

8. Select Next and select your paper and print settings as necessary.

190



9. Select Copies to change the number of copies as necessary.

Note: The number of copies you enter applies to each selected photo, including the number of prints
already selected for each.

10. When you are ready to print, select the Print icon.
Note: To cancel printing, select Cancel and select Close to exit.

Parent topic: Viewing and Printing Photos

Related references
Memory Card or External USB Device Print Settings

Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Memory Card or External USB Device Print Settings
Select the options you want to use when printing photos displayed on the LCD screen.

Note: Not all options or settings may be available, depending on other settings.

Print settings Available Description
options
Paper Size Various paper Indicates the size of paper you have loaded
sizes
Paper Type Various paper Indicates the type of paper you have loaded; see the list of
types paper types for copying (available options depend on the
selected Paper Size setting)
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Print settings Available Description
options

Paper Cassettes Cassette 1 Prints onto paper loaded in Cassette 1 (upper cassette)
Cassette 2 Prints onto paper loaded in Cassette 2 (lower cassette)

Cassette 1> 2

Prints onto paper loaded in Cassette 1 and then onto paper
loaded in Cassette 2 when the first cassette is empty (load
the same size and type of paper in both cassettes when
selecting this option)

Rear Paper Prints onto paper loaded in the rear paper feed slot
Feed Slot
Border Setting Borderless Expands the image to the edge of the paper (slight cropping
may occur)
With Border Leaves a small margin around the image
Expansion Standard Expands images correctly for most borderless prints
Medium Expands images slightly less for borderless prints
Minimum Expands images the least amount for borderless prints (you
may see some white border)
Fit Frame On Automatically crops the photo to fit into the selected photo
layout
Off Turns off automatic cropping
Quality Draft Provides lower quality for draft printing
Standard Provides good quality for most prints
High Provides higher quality for special prints
Best Provides the highest quality for important prints
Date Various date Prints the date the photo was taken on the photo in the
formats format you select
Off No date information is printed
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Print settings Available Description

options

Print Info on Photos | Camera Prints some Exif camera settings, such as shutter speed, f-
Settings ratio, or ISO sensitivity (if available)
Camera Text Prints text that you added in your camera

Note: Available on borderless photos in these sizes: 4 x 6
inches (102 x 152 mm), 5 x 7 inches (127 x 178 mm), and
16:9 wide (4 x 7.1 inches [102 x 181 mm]).

Landmark Prints location information embedded in a photo by cameras
with a built-in GPS feature

Note: Available on borderless photos in these sizes: 4 x 6
inches (102 x 152 mm), 5 x 7 inches (127 x 178 mm), and
16:9 wide (4 x 7.1 inches [102 x 181 mm]).

Off Turns off this setting
Clear All Settings Yes Restores all paper and print settings to their defaults
No

Parent topic: Viewing and Printing Photos

Related tasks
Viewing and Printing Photos From the LCD Screen

Printing Photo Layouts from a Memory Card with a Template

You can print one or more photos from a memory card in special layouts on various sizes of photo paper.
You can have the product automatically place the photos in the layout or you can manually place them
yourself.

1. Load photo paper in your product.
2. Insert a memory card into your product's memory card slot.
3. Press the 90r home button, if necessary.

Note: If Auto Selection Mode is turned on in the Guide Functions menu, select to function index
when you see the information screen.
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4. Select Print Photos.
5. Select Collage and select OK.
You see a screen like this:

e Lollage

{g} EE Print photo 1D @

Fhoto Collage

6. Select Photo Collage and select one of the displayed layout options.
7. Select a background type and design, if necessary.

Note: If you see a message telling you that loading photos is complete, select OK.

8. Do one of the following:

* To select a specific position for a photo, select a layout position, select the photo you want to print,
and select Done. Repeat these steps until all positions have a corresponding photo or all the
photos you want to print have been selected. Select Next.

» To layout the photos automatically, select Automatic Layout, select the photo(s) you want to
print, and select Next. To repeat a photo in a layout, select Single View and press the left or right
arrow button to scroll to the desired photo. Press the + or - button to adjust the number of prints for
the photo.

Note: If you select more photos than will fit in the layout you selected, the layout automatically
extends to multiple sheets. Select Yes on the confirmation screen to continue.

+ Select the photo you want to print and select Next. To repeat a photo in a layout, select Single
View and press the left or right arrow button to scroll to the desired photo. Press the + or - button
to adjust the number of prints for the photo.
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Note: If you select more photos than will fit in the layout you selected, the layout automatically
extends to multiple sheets.

9. Ifyou need to edit a photo, select Single View during photo selection and use the left or right arrow
to scroll to the photo you want to edit.

You see a screen like this:

e Select Photo =

1  Lets you zoom in and out of the photo.

2  Lets you apply filters, make color and red-eye corrections, and adjust cropping, rotation,
brightness, contrast, sharpness, and saturation if necessary.

Note: Press the Correction On button to switch between Correction Off and Correction On. With
Correction On selected, any corrections you make to a photo are displayed on the screen. With
Correction Off selected, any corrections you make will only be applied to your printouts.

10. Select your paper and print settings as necessary.
11. Select Copies to change the number of copies as necessary.
12. When you are ready to print, press the Print icon.

Note: To cancel printing, select Cancel and select Close to exit.
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Parent topic: Printing from a Memory Card

Related references

Memory Card or External USB Device Print Settings
Copying Options

Related tasks

Inserting a Memory Card

Related topics
Loading Paper

Printing ID Photos from a Memory Card

You can print ID photos from a memory card. Two copies of one photo are printed at different sizes onto
this size photo paper: 4 x 6 inches (102 x 152 mm).

1. Load photo paper in your product.
2. Insert a memory card into your product's memory card slot.
3. Press the 9r home button, if necessary.

Note: If Auto Selection Mode is turned on in the Guide Functions menu, select to function index
when you see the information screen.

4. Select Print Photos > Collage > Print Photo ID.
Note: If you see a message telling you that loading photos is complete, select OK.

5. Select any layout position on the sheet.
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You see a screen like this:

9 Salect Phobo

Single Wiew

6. Select the photo you want to print then select Done.

7. If you need to edit a photo, select Single View during photo selection and press the left or right
arrow button to scroll to the photo you want to edit.

You see a screen like this:

@ Select Photo

1  Lets you zoom in and out of the photo.
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2  Lets you apply filters, make color and red-eye corrections, and adjust cropping, rotation,
brightness, contrast, sharpness, and saturation if necessary.

Note: Press the Correction On button again to switch between Correction Off and Correction On.
With Correction On selected, any corrections you make to a photo are displayed on the screen.
With Correction Off selected, any corrections you make will only be applied to your printouts.

8. Confirm the layout and select Next.

9. Select your paper and print settings as necessary.

10. Select Copies to change the number of copies as necessary.
11. When you are ready to print, press the Print icon.

Note: To cancel printing, select Cancel and select Close to exit.

Parent topic: Printing from a Memory Card

Related references
Memory Card or External USB Device Print Settings

Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Creating and Printing a Greeting Card Template
Before you start, make sure plain paper is loaded and your memory card is inserted.
1. Press the 90 home button, if necessary.
2. Select Various Prints.
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3.

7.
8.
9.

Select Greeting Card and select OK.

3 (sroabng Cand

r_u Select Pholo and Print Templabe

f.'l\ FM Print Using the Template @

Select Select Photo and Print Template and select OK.
Do one of the following to select your photo:
+ Select the thumbnail image of the photo you want to print and select Next.

+ Select Single View, press the left or right arrow button to scroll to the photo you want to print, then
select Next. You can also select Tile View to return to the thumbnail image view.

Select Letter as the Paper Size to print a template for three cards on one letter-size sheet or 4x6in
to print a template for one card.

Confirm any changes, if necessary.
Select the Paper Type and Layout settings, as necessary.
Select Select Photo and Print Template.

10. When you are ready to print, press the Print icon.

Note: To cancel printing, select Cancel and select Close to exit.

11. When printing is finished, select Close.

Parent topic: Printing from a Memory Card

Related references
Memory Card or External USB Device Print Settings
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Related tasks
Inserting a Memory Card
Printing a Greeting Card from a Template

Related topics
Loading Paper
Printing a Greeting Card from a Template

After your greeting card template is printed, you fill it out to create your card and add your message.
1. Use a dark pen or pencil to fill in the circles and select the Text Style and Text Effects.

2. Add your greeting card message within the box. You can write it in by hand, print a message and
paste it into the box, or draw a picture.

Note: When adding text, place it in the direction that your photo faces.

3. Load photo paper in Cassette 2 (lower) for this size: Letter (8.5 x 11 inches [216 x 279 mm]), or in
Cassette 1 (upper) for this size: 4 x 6 inches (102 x 152 mm).

4. Select Print using Template sheet.

Note: If you do not see Print using Template sheet, press the 41t home button and select Various
Prints > Greeting Card > OK > Print Using the Template. Then select OK twice.
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5. Select Edit to adjust image settings, if necessary.

6. Select How To and follow the instructions on the LCD screen to place the template facedown on the
scanner glass with the blue triangle facing into the front right corner.

7. Close the document cover.
Select Copies and use the numeric keypad to select the number of copies (up to 99).
9. When you are ready to print, press the Print icon.

Note: To cancel printing, select Cancel and select Close to exit.

When you finish printing, cut your greeting cards apart, if necessary.
Parent topic: Printing from a Memory Card

Related topics
Loading Paper

Transferring Photos on a Memory Card
You can transfer photos to and from a memory card inserted into a memory card slot on your product.

Setting Up File Sharing for Photo Transfers from Your Computer
Transferring Photos from a Memory Card to Your Computer

Parent topic: Using Memory Cards with Your Product

Setting Up File Sharing for Photo Transfers from Your Computer
Before you transfer photos from a computer to a memory card inserted into a memory card slot on your
product, you may need to set up your product's file sharing settings.

Caution: Remove the memory card before you change this setting or you may lose data from the
memory card. Do not remove a memory card or turn off your product while the memory card access light
is flashing or you may lose data from the memory card.

1. Remove any memory cards from the product.
2. Press the 90t home icon, if necessary.
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3. Select Settings.
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4. Select File Sharing Setup.

5. Select your connection type.

6. Press the 7 home icon to exit.

Parent topic: Transferring Photos on a Memory Card

Related tasks
Inserting a Memory Card
Removing a Memory Card

Transferring Photos from a Memory Card to Your Computer

You can transfer photos to and from a memory card inserted into a memory card slot on your product
and a computer connected to your product.

Note: Do not transfer photos to and from a memory card while you are printing from the memory card.

Make sure your product is connected to a computer.
2. Insert a memory card into a memory card slot on your product.
3. Do one of the following to access your memory card files from your computer:

* Windows: Open the Computer, My Computer, Windows Explorer, or File Explorer utility, then
select the removable disk icon.
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* Mac with a USB connection: Look for the removable disk icon on your desktop or computer
window, then select it.

* Mac with a network connection: Select the hard drive icon on your desktop or computer window,
select your product in the SHARED section of the sidebar (you may need to widen the sidebar to
see the name), then select the MEMORYCARD icon.

4. Select the folder that contains your photos.
5. Drag the photos you want to transfer to the desired folder on your computer or on your memory card.

Note: Your product's LCD screen does not update to display new photos transferred to the memory
card. Wait until the memory card access light stops flashing, then remove and insert the memory card to
update the photos displayed.

Parent topic: Transferring Photos on a Memory Card
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Using an External Device with Your Product

Follow the instructions in these sections to use your product with an external device, such as a camera,
smartphone, or other device.

Printing from a Camera
Viewing or Printing from a USB Flash Drive or External Device

Printing from a Camera

If you have a digital camera that supports PictBridge printing, you can print your photos directly from the
camera. Check your camera manual to see if it is compatible.

Note: Your photos must be in JPG format and sized from 80 x 80 to 10200 x 10200 pixels. Epson
cannot guarantee the compatibility of your camera. Some combinations of paper type, size, and layout
may not be supported, depending on your camera and the product settings.

Selecting Print and Photo Adjustment Settings
Connecting and Printing from a Camera
Printing from a Camera Wirelessly

Parent topic: Using an External Device with Your Product

Selecting Print and Photo Adjustment Settings

Before printing from your camera, you can make image adjustments and select the print settings for your
photos. Image adjustments affect only the printed copy of the photo, not the original file.

1. Press the 90 home button, if necessary.
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2. Select Settings.
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@ Gamaera Prind Somngs
Print Satlings
{n"} Photo Adjustments @
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4. Select Print Settings.
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5. Select the paper and print settings you want to use.
6. When you are done, press Q.
7. Select Photo Adjustments.
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8. Select the photo adjustments you want to use.
9. Press the fi* home button to exit.

After you select settings, you are ready to connect your camera and print your photos.
Print Settings - Camera
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Photo Adjustments - Camera

Parent topic: Printing from a Camera

Related tasks

Connecting and Printing from a Camera

Print Settings - Camera

Select these print settings options when printing photos from your camera.

Print settings

Available options

Description

Paper Size

Various paper sizes

Indicates the size of paper you have loaded

Paper Type

Various paper types

Indicates the type of paper you have loaded; see
the list of paper types for copying (available
options depend on the selected Paper Size
setting)

Paper Cassettes

Cassette 1 Prints onto paper loaded in Cassette 1 (upper
cassette)
Cassette 2 Prints onto paper loaded in Cassette 2 (lower

cassette)

Cassette 1> 2

Prints onto paper loaded in Cassette 1 and then
onto paper loaded in Cassette 2 when the first
cassette is empty (load the same size and type of
paper in both cassettes when selecting this option)

Rear Paper Feed Slot

Prints onto paper loaded in the Rear Paper Feed
Slot

Border

Borderless Expands the image to the edge of the paper (slight
cropping may occur)

With Border Leaves a small margin around the image

Expansion

Standard Expands images correctly for most borderless
prints

Medium Expands images slightly less for borderless prints

Minimum Expands images the least for borderless prints

(you may see some white border)
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Print settings

Available options

Description

Fit Frame On Automatically crops the photo to fit into the
selected photo layout
Off Turns off automatic cropping
Quality Draft Provides lower quality for draft printing
Standard Provides good quality for most prints
High Provides higher quality for special prints
Best Provides the highest quality for important prints
Date Off Does not print the date on which the photo was
taken
On Prints the date on which the photo was taken

Print Info on Photos

Camera Settings

Prints some Exif camera settings, such as shutter
speed, f-ratio, or ISO sensitivity (if available)

Camera Text

Prints text that you added in your camera

Available on borderless photos in these sizes:
4 x 6 inches (102 x 152 mm), 5 x 7 inches
(127 x 178 mm), and 16:9 wide (4 x 7.1 inches
[102 x 181 mm])

Landmark Prints location information embedded in a photo by
cameras that have a built-in GPS feature
Available on borderless photos in these sizes:
4 x 6 inches (102 x 152 mm), 5 x 7 inches
(127 x 178 mm), and 16:9 wide (4 x 7.1 inches
[102 x 181 mm])

Off Prints no information on photos

Clear All Settings Yes Restore all paper and print settings to their defaults
No

Parent topic: Selecting Print and Photo Adjustment Settings

Photo Adjustments - Camera

Select these photo adjustment options when printing photos from your camera. The modifications affect
only the printed copy of the photo, not the original file.
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Photo Available options Description

Adjustments

settings

Fix Photo Auto Optimizes the Fix Photo adjustments for specific types of
Peoble photos; select the option that best matches your photo

P content

Landscape
Night Scene
Enhance Off Turns off the enhancement feature

Fix Red-Eye Off - Current Does not automatically fix the red-eye effect in photos
On - Current Automatically fixes the red-eye effect in photos

Filter Off Turns off the filter setting
Sepia Applies a sepia tone filter to the viewed or printed photo
B&W Applies a black-and-white filter to the viewed or printed

photo

Brightness Various settings Adjust individual qualities in your photo

Contrast

Sharpness

Saturation

Clear All Yes Restores all adjustment settings to their defaults

Settings No

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Selecting Print and Photo Adjustment Settings

Connecting and Printing from a Camera
Before you connect your camera, make sure the product is turned on but not printing.
1. Remove any memory cards or external USB devices from the product.
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2. Load the paper you want to print on.
Turn on your camera.

Connect the USB cable that came with your camera to the 24 USB port on the front of your product
and to your camera.

(| )

Note: Use a USB cable that is no longer than 6.5 ft (2 m).

5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the product.
Parent topic: Printing from a Camera

Related tasks
Removing a Memory Card
Connecting and Using a USB Flash Drive or External Device

Related topics
Loading Paper

Printing from a Camera Wirelessly

You can print photos from a digital camera using a wireless connection. Make sure your digital camera
can connect to a network and is PictBridge compatible (DPS over IP).

Note: You cannot use other product functions or print from other devices while using PictBridge.
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Remove any memory cards from the product.
Load the paper you want to print on.
Turn on your camera.

b~

Set up the camera's wireless network connection. See the documentation that came with your
camera for details.

Note: Connect the camera to the same network that your product uses. You can print a Network
Status sheet to view your product's network settings.

5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the network.
Parent topic: Printing from a Camera

Related tasks

Printing a Network Status Sheet

Removing a Memory Card

Connecting and Using a USB Flash Drive or External Device

Related topics
Loading Paper

Viewing or Printing from a USB Flash Drive or External Device

You can view and print photos from a USB flash drive or other external USB device, such as an external
hard drive or CD/DVD burner.

Note: Make sure the files on your device are compatible with the product.

USB Device File Specifications
Connecting and Using a USB Flash Drive or External Device

Parent topic: Using an External Device with Your Product

USB Device File Specifications
You can print external device files that meet these specifications.
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File format JPEG with the Exif version 2.3 standard (taken with digital camera
using DCF (Design rule for Camera File system) version 1.0 or 2.0

compliant)
Image size 80 x 80 pixels to 10200 x 10200 pixels
File size Up to 2GB
Number of files Up to 9990

Note: DCF 2.0 files stored in a camera's built-in memory are not supported.
Parent topic: Viewing or Printing from a USB Flash Drive or External Device

Connecting and Using a USB Flash Drive or External Device

Before you connect your USB flash drive or external device, make sure the product is turned on but not
printing.

Note: Epson cannot guarantee the compatibility of your device.

1. Remove any memory cards from the product.

\_/\
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Caution: Do not remove a memory card or turn off your product while the memory card access light
is flashing or you may lose data from the memory card.

2. Load the paper you want to print on.
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3. Insert your USB flash drive or the USB cable that came with your device into the 74 USB port on the
front of your product.

4. Insert storage media (such as a CD) into your drive, if necessary.
5. Select the photos to print from the LCD screen.

When you finish printing, make sure the access light on the device is not flashing, then remove or
disconnect it from the product.

Caution: Do not remove the USB device or turn off the product when the access light is flashing, or you
may lose photos on the device.

Parent topic: Viewing or Printing from a USB Flash Drive or External Device

Related tasks

Connecting and Printing from a Camera

Removing a Memory Card

Viewing and Printing Photos From the LCD Screen
Related topics

Loading Paper

213



Printing Personalized Projects

You can print a variety of personalized projects, including some with a photo background.
Printing a Personalized Project

Printing a Personalized Project

You can print patterned paper, calendars, lined paper, graph paper, music sheets, stationery with a
photo background, or coloring book pages. You can also print images from a memory card onto
CD/DVDs and jewel case inserts.

1. Load plain paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7 inches
[210 x 297 mm)]) size.

2. Select the 9 home icon, if necessary.
3. Select Various Prints.
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4. Select one of the following:
* Personal Stationery lets you print a variety of project types on paper:
* Design Paper lets you print patterned paper from preset designs.

» Calendar lets you create and print a weekly or monthly calendar page using photos stored on a
memory device.

» Schedule lets you create and print a monthly, weekly, or daily schedule page.
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* Ruled Paper lets you print music sheets, wide-rule or narrow-rule notebook paper, and graph
paper.

» Writing Papers lets you print lined or unlined note paper with one of your own photos in the
background.

» Copy to CD/DVD lets you print a variety of projects onto a CD/DVD or jewel case insert:

* Print on CD/DVD lets you print one or more photos from a memory card or external USB device
directly onto an ink jet-printable CD, DVD, or Blu-ray Disc. If you want, you can first print a test
design on plain paper.

* Print on Jewel Case lets you print a photo from a memory card or external USB device onto a
CD/DVD jewel case insert. Your product automatically resizes the photo to fit, but you can also
print multiple thumbnail images formatted to fit on a jewel case insert. After the insert is printed,
you can cut and fold it to fit.

» Coloring Books lets you create a coloring book page from a photo on your memory card or
external USB device, or from a photo or drawing placed on the scanner glass.

5. Follow the instructions on the screen to select the options for your project.
6. When you are ready to print, select the Print icon.

Note: To cancel printing, select Cancel and select Close to exit.

Parent topic: Printing Personalized Projects

Related references

Memory Card or External USB Device Print Settings
Related tasks

Connecting and Using a USB Flash Drive or External Device
Inserting a Memory Card

Related topics

Printing on CDs/DVDs

Loading Paper

Placing Originals on the Product
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Printing on CDs/DVDs

Follow the instructions in this section to print a design onto ink jet-printable CDs or DVDs to create a
custom label.

CD/DVD Printing Features
Loading a CD/DVD
Copying onto a CD/DVD

CD/DVD Printing Features

You can use any of the following features to print custom CD/DVD/Blu-ray Disc labels and accessories:
» Copy an existing label onto a new CD/DVD/Blu-ray Disc

» Use your product's control panel to print photos from a memory card onto a CD/DVD/Blu-ray Disc

» Print text and images from your computer using the Epson Photo+ software

You can also use your product's control panel to create a jewel case insert with photos from a memory
card.

Parent topic: Printing on CDs/DVDs

Related concepts
Printing with Epson Photo+

Related tasks
Copying onto a CD/DVD
Printing a Personalized Project

Loading a CD/DVD

You can print on any compatible, ink jet-printable CDs or DVDs, including Blu-ray Discs.

Caution: Do notinsert the CD/DVD tray while the product is printing, copying, or performing other
operations. Otherwise, your product may be damaged or the surface of the CD/DVD may become dirty
or scratched.

Note: If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the center
hole, you may need to adjust the inner diameter setting using the control panel or Epson Photo+
software.
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Burn your files, music, or video onto your disc before printing on it.
Press the 4 home button, if necessary.

Raise the control panel.

Make sure nothing is on the output tray, then press the EEEES icon to close it.
Remove the CD/DVD tray from beneath cassette 2.
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6. When prompted to load a CD/DVD, you can select the option to view an animation of the loading
procedure. Follow the on-screen instruction to load the disc into the CD/DVD tray.

Note: Be sure to fully seat the CD or DVD or it may fall out when the tray is turned over.

Caution: Do not turn off the product with a CD or DVD loaded in it. Always remove the disc first.

After your CD or DVD is printed, the tray extends automatically. Remove it from your product, remove
the CD or DVD from the tray, and select Printing Complete on the LCD screen. Make sure you insert
the CD/DVD tray into the storage slot beneath Cassette 2 when you're finished.

Caution: Always remove the CD/DVD tray after printing. If you turn the product off and on again or
perform a head cleaning without removing the tray, the print head may contact the CD/DVD tray and
cause the product to malfunction. After printing, handle the CD or DVD carefully. You may need to wait
up to 24 hours for the ink to dry fully before inserting it in a drive, depending on the type of disc you used.
Keep printed discs away from moisture and direct sunlight.

Parent topic: Printing on CDs/DVDs

Copying onto a CD/DVD

You can copy a printed photo or CD/DVD label directly onto an ink jet-printable CD or DVD. If you want,
you can first print a test design on plain paper.
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Load the CD, DVD, or plain paper you want to print on.

Press the 40+ home button, if necessary.

Select Various Prints.

Select Copy to CD/DVD and select OK.

Select Copy to CD/DVD and follow the instructions on the LCD screen to do one of the following:
» Place your photo facedown on the scanner glass.

* Place your CD or DVD facedown in the center of the scanner glass.

Select Proceed to set up Outer/Inner.

If necessary, adjust the inner and outer diameter of your CD as shown on the screen, and select
Select Type.

You see this screen:
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Do one of the following:

* To printon a CD or DVD, select Print on CD/DVD. Select How To to view CD loading instructions
or select Installed if the CD is already loaded.

» To print a test print on plain paper, select Test Print on Letter/A4. Select any copy settings as
necessary.

When you are ready to print, select Print on CD/DVD.

Note: To cancel printing, select Cancel and select OK to exit.
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Parent topic: Printing on CDs/DVDs

Related references
Printable Area Specifications
Related tasks

Loading a CD/DVD

Related topics
Placing Originals on the Product
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Replacing Ink Cartridges and Maintenance Boxes
The maintenance box stores ink that gets flushed from the system during print head cleaning. When an
ink cartridge is expended or the maintenance box is at the end of its service life, you need to replace it.

You may also need to replace a cartridge that is more than six months old if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly
and in accordance with local requirements. If you would like to return your used ink cartridges and
maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing Ink Cartridges

Printing with Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows

Replacing the Maintenance Box

Check Cartridge and Maintenance Box Status

Your product and its software will let you know when an ink cartridge is low or expended, or when the
maintenance box needs to be replaced.

Checking Ink Cartridge and Maintenance Box Status on the LCD Screen
Checking Cartridge and Maintenance Box Status - Windows
Checking Cartridge and Maintenance Box Status - Mac

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Checking Ink Cartridge and Maintenance Box Status on the LCD Screen
You can check the status of the ink cartridges and maintenance box using the product's LCD screen.
1. Press the 90 home button, if necessary.

2. Select the ‘ icon.
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You see a screen like this:

Cloze Supply Stahig
I Lyl
| | 11 |
o — - @

G ¥ LM
Sbereetmieiad T
of Mainignancd box

Roplaco ink Print Supply Stahes
Crariricgeys) Shoet

Note: The displayed ink and maintenance box levels are approximate. If you see a low ink message,
you can continue printing until you see a message to replace an ink cartridge.

3. To print detailed status information, make sure paper is loaded in your product and select Print
Supply Status Sheet.

4. If youwant to replace an ink cartridge, select Replace Ink Cartridge(s) and follow the on-screen
instructions.

Parent topic: Check Cartridge and Maintenance Box Status

Related tasks
Removing and Installing Ink Cartridges
Replacing the Maintenance Box

Checking Cartridge and Maintenance Box Status - Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge or
maintenance box status at any time using a utility on your Windows computer.

Note: If you see a low ink message, you can continue printing until you see a message to replace an ink
cartridge.

1. To check your status, access the Windows Desktop and double-click the 3;-} icon for your product in
the right side of the Windows taskbar, or click the up arrow and double-click 2.
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You see this window:

fn. EPS0OM Status Monitor 3 —
EPSON "
It ready to prnt.
0 Support
4 Consumables Status
I s
L e
[ Light Cvan
Cyan
¥ edow
Light Magenta
Irifesrenation
Mairvtenancs Bax Service Life
Pt e C o ] soveomontn

2. Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.
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3. Todisable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.

You see this window:

Monitoring Preferences : ERSON ? x
Select Notification
Event Screen Motification o]
& Errar On
O Commumnication Error Off
E Printer Selection Error on
O Ink Lowe off H,
[] simple status notification Default
Select Shortout Tcon

] Register the shortcut icon to the taskbar

Double-dicking the Shortout Icon
opens the Printer Status Window.

[ ] Allow monitoring of shared printers
[] 5ee Low Ink Reminder alerts
[ Display Epson Offers

Cancel heb

4. Deselect the See Low Ink Reminder alerts checkbox at the bottom of the screen.

5. To disable promotional offers, deselect the Display Epson Offers checkbox.
6. Click OK.

Parent topic: Check Cartridge and Maintenance Box Status
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Related tasks

Removing and Installing Ink Cartridges
Replacing the Maintenance Box
Printing with Expended Color Cartridges - Windows

Checking Cartridge and Maintenance Box Status - Mac

You can check the status of your ink cartridges and maintenance box using a utility on your Mac.

Note: If you see a low ink message, you can continue printing until you see a message to replace an ink
cartridge.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
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You see this window:

@ Epson Printer Litility 4

@

Bury Epson fnk

EPSON eesox

% EPSON Status Monitor

ik, Levals

[N s Ligha Cyam i LT L Wt

Information

@ |

Maintenance Box Service Life

Updste | (S

3. Do the following as necessary:
* You can update the ink cartridge and maintenance box status by clicking Update.
* Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge and Maintenance Box Status
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Related tasks

Removing and Installing Ink Cartridges
Replacing the Maintenance Box

Printing with Expended Color Cartridges - Mac

Purchase Epson Ink Cartridges and Maintenance Box

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales) or
epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find
the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Note: Your printer is designed to work only with genuine Epson-brand ink cartridges. Other brands of ink
cartridges and ink supplies are not compatible and, even if described as compatible, may not function
properly or at all. Epson periodically provides firmware updates to address issues of security,
performance, minor bug fixes and ensure the printer functions as designed. These updates may affect
the functionality of third-party ink. Non-Epson branded or altered Epson cartridges that functioned prior
to a firmware update may not continue to function.

The included initial cartridges are designed for reliable printer setup and cannot be used as replacement
cartridges or resold. After setup, the remaining ink is available for printing. Yields are based on ISO
24711 in default mode, printing continuously. Yields vary due to print images, settings, and
temperatures. Printing infrequently or primarily with one color reduces yields. All cartridges must be
installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced
cartridges.

Ink Cartridge and Maintenance Box Part Numbers
Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Ink Cartridge and Maintenance Box Part Numbers
Use these part numbers when you order or purchase a new maintenance box or ink cartridges.
Maintenance box part number: T3661

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Ink color Part number
Standard-capacity High-capacity
Black 312120 312XL120
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Ink color Part number

Standard-capacity High-capacity
Cyan 312220 312XL220
Magenta 312320 312XL320
Yellow 312420 312XL420
Light Cyan 312520 312XL520
Light Magenta 312620 312XL620

Parent topic: Purchase Epson Ink Cartridges and Maintenance Box

Related references
Ink Cartridge Specifications

Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the product until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

Note: If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.

1. Turn on your product.

+ Ifanink cartridge is expended, you see a message on the LCD screen. Note which cartridges
need to be replaced and follow the on-screen instructions or the instructions below to replace the
cartridge.

« If you are replacing a cartridge before you see a message on the LCD screen, press the 41t home
button if necessary, and select Maintenance > Ink Cartridge Replacement. Select Next and
select Start.

Note: You can also select How To to view ink replacement instructions on the LCD screen.

228



2. Lift up the scanner unit.

Caution: Be careful not to trap your hand or fingers when opening or closing the scanner unit.
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The ink cartridge holder moves to the replacement position. If the ink cartridge holder returns to the
home position (far right), repeat steps 1 and 2.
-

] \ )
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Caution: Do not move the print head by hand or use any kind of tool to remove a cartridge;
otherwise, you may damage your product. Do not touch the flat white cable or the metal bar inside
the product.

3. Push in the blue tab to unlock the ink cartridge you are replacing. Then lift the ink cartridge as shown
to remove it.

olo @
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Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If discomfort or vision problems persist, see a doctor
immediately. If ink gets into your mouth, spit it out and see a doctor right away. Keep ink cartridges
out of the reach of children.

Note: Replace ink cartridges one after another as quickly as possible. If you replace two or more
cartridges at a time or replacement takes time, some ink may be consumed to guarantee printer
performance.

Caution: Be careful not to let dust or any objects get inside the ink cartridge holder. Anything inside
the holder may adversely affect the printing results or result in an inability to print.

Recap the used ink cartridge using the cap that came with it. You can also use the cap from your
replacement cartridge package.

I’

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.
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5. Remove the new ink cartridge from the package.

g

Caution: Do not drop or shake the ink cartridges. Do not squeeze them or tear their labels; doing so
may cause the ink cartridge to leak.

6. Remove the cap from the cartridge and save the cap so you can recap ink cartridges before storing
or disposing of them.
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Caution: Do not remove any other labels or seals, or the ink cartridge may leak or become
unusable. Do not touch the areas shown here; doing so may prevent normal operation and printing.

Insert the new cartridge into the ink cartridge holder at an angle as shown. Then push it all the way
down until it clicks into place.

After you replace all the cartridges that need replacing, lower the scanner unit and select
Completed on the LCD screen.

Note: The scanner unit is designed to close slowly as a precaution against trapping fingers.
Continue to close the scanner unit even if you feel some resistance.

The print head moves to its home position and the product starts charging the ink. This takes a few
minutes. When you see a completion message on the LCD screen, ink replacement is complete.
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Note: If you see an error screen telling you an ink cartridge is installed incorrectly, lift up the scanner
unit and press the ink cartridge down until it clicks into place. When you're finished, close the
scanner unit.

Caution: Do not turn off the product while ink is charging or you may not be able to print.

Caution: If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came
with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.
Store the ink cartridge in the same environment as the product. Do not leave the product with the ink
cartridges removed for an extended period of time. Otherwise, ink remaining in the print head nozzles
may dry out and you may not be able to print.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Related concepts
Purchase Epson Ink Cartridges and Maintenance Box

Related references
Ink Cartridge Safety Instructions

Printing with Black Ink and Expended Color Cartridges

When a color ink cartridge is expended, you can temporarily continue printing using black ink. Replace
the expended color cartridge as soon as possible for future printing.

Printing with Expended Color Cartridges - Windows
Printing with Expended Color Cartridges - Mac

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Printing with Expended Color Cartridges - Windows

If you see a message during printing telling you that you can temporarily print in black ink with an
expended color cartridge, you can cancel your print job and select settings to print on plain paper or on
an envelope.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Note: To use this feature, Epson Status Monitor must be enabled.
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Load plain paper or an envelope in your product.

Access the print settings in your print application.

Click the Main tab.

Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
Click OK.

Print your document.

Epson Status Monitor 3 displays a print message.

Click Print in Black to print your document.

Parent topic: Printing with Black Ink and Expended Color Cartridges

Related topics
Loading Paper

Printing with Expended Color Cartridges - Mac

If printing stops, you can cancel your print job and select settings to temporarily print with only black ink
on plain paper or on an envelope.

1.
2.

® N o

9.

Click the printer icon in the Dock.

If you see a message telling you that you can temporarily print with only black ink, click the Delete or
button to cancel your print job. If you see an error message, click OK.

In the Apple menu or the Dock, select System Preferences.

Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

Select Driver or Options.

You see a screen like this:

Select On as the Permit temporary black printing setting.
Click OK.

Close the utility window.

Load plain paper or an envelope in your product.

10. Access the print settings in your print application.

11. Select Print Settings from the pop-up menu.
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12. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
13. Select the Grayscale option.

14. Click Print to print your document.

Parent topic: Printing with Black Ink and Expended Color Cartridges

Related topics
Loading Paper

Conserving Low Black Ink with Windows
The following window appears when black ink runs low and there is more color ink.

[ EPSON Status Monitor 3

Black ink is bow. You can extend black ink cartridge ife by printing with a
mixture of other colors to oreate compedsite black,
Do you want to do this for the current print job?

res ]

[ ]

Disable this feature

Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper
type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor
must be enabled.

» Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink
for the document you are printing.

+ Click Disable this feature to continue using the remaining black ink.
Note: If you disable this feature, it remains disabled until you install a new black ink cartridge.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes
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Replacing the Maintenance Box
Make sure you have a new maintenance box before you begin.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for more than a
week. Keep the maintenance box away from direct sunlight.

Note: You cannot print or clean the print head while the maintenance box is full, but you can perform
tasks that do not require ink, such as scanning.

1. Make sure the product is not printing.
2. Remove the new maintenance box from its package.

Caution: Do not touch the areas shown here:

g
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3. Lift up Cassette 2 and pull it out all the way.
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5. Use a flat-head screwdriver to loosen the screw on the maintenance box cover and remove the
maintenance box cover as shown.

—\

i
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o
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Note: Do not tilt the used maintenance box or take it apart.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If discomfort or vision problems persist, see a doctor
immediately. If ink gets into your mouth, spit it out and see a doctor right away. Keep the
maintenance box out of the reach of children and do not drink the ink.

7. Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal
the bag and dispose of it carefully.

8. Insert the new maintenance box into the holder and push it all the way in.
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9. Insert the maintenance box cover into the tabs on the product as shown, close the cover, and tighten
the screw to secure it.

10. Re-insert Cassette 2 and follow the on-screen instructions.
Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Related references
Ink Cartridge and Maintenance Box Part Numbers

Related tasks
Removing and Installing Ink Cartridges
Replacing the Maintenance Box
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Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

If running these utilities does not solve the problem, the translucent film inside the printer may be
smeared or you may need to replace the ink cartridges.

Print Head Maintenance
Aligning the Print Head Using the Product Control Panel
Cleaning the Paper Guide

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning
Power Cleaning

Parent topic: Adjusting Print Quality

Related concepts
Purchase Epson Ink Cartridges and Maintenance Box

Related tasks
Removing and Installing Ink Cartridges

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.
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Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance
Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load afew sheets of plain paper in Cassette 2.
3. Press the 9r home button, if necessary.
4. Select Maintenance.
You see a screen like this:

9 hLaimionanoo

Print Hoad MNozzie
Check

fnl\_\ % Print Head Cleaning

&\" Power Cleaning

@O e

i}ﬁ"l. Print Head Algnment

5. Select Print Head Nozzle Check.
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You see a screen like this:

@ Print Head Mozzle Check

Load Lalter/A4 size paper in the
ﬂ:} Cassetie 2 io Mozzle Check Pattern. @

6. Select Print.
The nozzle pattern prints.
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Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Do one of the following:
« If there are no gaps, select O.
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+ If there are gaps or the pattern is faint, select X and then select Cleaning.
« If all or most of the lines are missing, select X and then select Power Cleaning.

9. Follow the instructions on the screen to clean the print head or run a power cleaning, check the
nozzles, and repeat the process if necessary.

Caution: Never turn off the product or open the scanner unit during a cleaning cycle or you may not
be able to print.

If you don't see any improvement after cleaning the print head three times, turn off the product and wait
at least 12 hours. Then run a nozzle check and try cleaning the print head again. If quality still does not
improve, run a Power Cleaning.

Parent topic: Print Head Nozzle Check

Related concepts
Print Head Cleaning
Power Cleaning

Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Checking the Nozzles Using a Computer Utility

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Load a few sheets of plain paper in Cassette 2 (lower).
2. Do one of the following:

* Windows: Access the Windows Desktop and right-click the & icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

3. Select Print Head Nozzle Check.
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You see a window like this:

Print Head Mozzle Check »
w

To perform a nozde chedk, make sure that the printer is on and
connectied to the computer, Make sure that the CO/DVD ray is
removed; otherwise Print Head Mozzde Chedk”™ cannot be performed.
Also make sure that A% or Letter size plain paper i loaded in the
cassette 2, Chdk [Print] to print a nozzle chedk pattern or dick [Cancel]
to quit.

Click Print.
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Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Do one of the following:
« If there are no gaps, click Finish.
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 If there are gaps or the pattern is faint, clean the print head.
« If almost the entire pattern is missing, click Finish and perform a Power Cleaning.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then run a nozzle check and try cleaning the print head again. If quality still does not
improve, run a Power Cleaning.

Parent topic: Print Head Nozzle Check

Related concepts
Print Head Cleaning
Power Cleaning

Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Checking the Nozzles Using the Product Control Panel

Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance
Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in Cassette 2.
3. Press the 9 home button, if necessary.
4. Select Maintenance.
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You see a screen like this:

9 KA NANoD

Print Hoead MNozzie
Check ﬂ'

‘ﬁ:} {57 Print Head Cleaning () @
IH.‘\'& Power Cleaning (7]
h.'ﬁ. Print Head Alignment () @

5. Select Print Head Cleaning.
You see a screen like this:

@ Print Head Cleaning

Cleaning starts, and then the nozzle
1;‘} check pattern is pﬁmﬂd.

Load Letles/Ad size plain paper in the

Gassalie 2,

6. Select Start to clean the print head.

The O power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished. When the cleaning cycle is finished, you see a message on the screen.

Caution: Never turn off the product or open the scanner unit during a cleaning cycle or you may not
be able to print.
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Select Check.

Select Print to print a nozzle check pattern and confirm that the print head is clean.
Check the printed pattern to see if there are gaps in the lines.

Print head is clean

Print head needs cleaning
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10. Do one of the following:

+ If there are no gaps, select O.

« If there are gaps or the pattern is faint, select X and then select Cleaning.

+ If all or most of the lines are missing, select X and then select Power Cleaning.
11. Follow the instructions on the screen to clean the print head or run a power cleaning.

Caution: Never turn off the product or open the scanner unit during a cleaning cycle or you may not
be able to print.

If you don’t see any improvement after cleaning the print head three times, turn off the product and wait
at least 12 hours. Then run a nozzle check and try cleaning the print head again. If quality still does not
improve, run a Power Cleaning.

Parent topic: Print Head Cleaning

Related concepts
Print Head Cleaning
Power Cleaning

Related tasks

Removing and Installing Ink Cartridges

Loading Paper in Cassette 2 (Lower Cassette)
Cleaning the Print Head Using a Computer Utility

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load afew sheets of plain paper in Cassette 2 (lower).
3. Do one of the following:

* Windows: Access the Windows Desktop and right-click the & icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click 2.

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Print Head Cleaning.
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You see a window like this:

% Print Head Cleaning

Salect one of the radio buttons below according to the result of the
nozzle check, and then dick [Next] to dean the print head nozzles.
Because deaning consumes some ink, only dean the print head when
faint areas or gaps appear in your printout. Lise the Print Head

Mozzie Chedk”™ uthity first to confirm that the print head needs to be
deaned.

prery— >

5. Select the cleaning cycle you want to run, based on the nozzle check pattern and click Next.
6. Click Start to begin the cleaning cycle.

The O power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product or open the scanner unit during a cleaning cycle or you may not
be able to print.
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When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

« If there are no gaps, click Finish.
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+ If there are gaps or the pattern is faint, click Clean to clean the print head again.
« If almost the entire pattern is missing, click Finish and perform a Power Cleaning.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then check the print head nozzles and try cleaning the print head again, if necessary.

Parent topic: Print Head Cleaning

Related concepts
Print Head Cleaning
Power Cleaning

Related tasks

Removing and Installing Ink Cartridges

Loading Paper in Cassette 2 (Lower Cassette)

Cleaning the Print Head Using the Product Control Panel

Power Cleaning

If you still see white or dark lines or missing nozzles in your printouts, even after cleaning the print head
several times, you can run a Power Cleaning.

If you do not see improvement after running a Power Cleaning, turn off the product and wait at least 12
hours before running another Power Cleaning.

Caution: Power Cleaning may cause the maintenance box to reach its capacity sooner. When the
maintenance box is full, you need to replace it to continue printing.

Note: Power Cleaning consumes more ink than Print Head Cleaning.

Power Cleaning Using the Product Control Panel
Power Cleaning Using a Computer Utility

Parent topic: Print Head Maintenance
Power Cleaning Using the Product Control Panel
You can run a Power Cleaning using the control panel on your product.

Note: After running a Power Cleaning, you must turn off the product and wait at least 12 hours before
printing a nozzle check pattern and running another Power Cleaning or Print Head Cleaning.

1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
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Load a few sheets of plain paper in Cassette 2.
Press the 40+ home button, if necessary.

4. Select Maintenance.
You see a screen like this:

9 TR T

Prinl Haad Mozzhs
Chack

‘[F\I_‘ ' Print Head Claaning

N\' Power Cleaning

@S

-E_'LJ,-,I Print Haad Algnment

5. Select Power Cleaning.
6. Select Start.

The O power light flashes throughout the cleaning cycle and stays on until the nozzle check pattern
is printed. After the nozzle check pattern is printed, you see a message on the screen.

Caution: Never turn off the product or open the scanner unit during a cleaning cycle or you may not
be able to print.

7. Select OK.

If the print quality did not improve, you must turn off the product and wait at least 12 hours before printing
another nozzle check pattern and running another Power Cleaning or Print Head Cleaning.

If the print quality does not improve after running the Power Cleaning utility multiple times, contact Epson
for support.

Parent topic: Power Cleaning

Related concepts
Print Head Nozzle Check
Print Head Cleaning
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Related references
Where to Get Help

Related tasks
Loading Paper in Cassette 2 (Lower Cassette)

Power Cleaning Using a Computer Utility
You can run a Power Cleaning using a utility on your Windows or Mac computer.

Note: After running a Power Cleaning, you must turn off the product and wait at least 12 hours before
printing a nozzle check pattern and running another Print Head Cleaning or Power Cleaning.

Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load afew sheets of plain paper in Cassette 2.
3. Do one of the following:

* Windows: Access the Windows Desktop and right-click the % icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click 2.

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Print Head Cleaning.
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You see a window like this:

% Print Head Cleaning »

Salect one of the radio buttons below according to the result of the
nozzle check, and then dick [Next] to dean the print head nozzles.
Because deaning consumes some ink, only dean the print head when
faint areas o gaps appear in your printout. Use the Print Head
Mozzie Chedk”™ uthity first to confirm that the print head needs to be
deaned.

Print Nozze Chedk Pattern Mext >

5. Select Power Cleaning and click Next.
6. Follow the on-screen instructions to run a Power Cleaning.

7. When the Power Cleaning is finished, click Print Nozzle Check Pattern and follow the on-screen
instructions to print a nozzle check pattern.

If the print quality did not improve, you must turn off the product and wait at least 12 hours before printing
a nozzle check pattern and running another Power Cleaning or Print Head Cleaning.

If the print quality does not improve after running the Power Cleaning utility multiple times, contact Epson
for support.
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Parent topic: Power Cleaning

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Where to Get Help

Related tasks
Loading Paper in Cassette 2 (Lower Cassette)

Aligning the Print Head Using the Product Control Panel

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
Load a few sheets of plain paper in Cassette 2.
Press the 91 home button, if necessary.

e

Select Maintenance.
You see a screen like this:

@ hEaimionance

Prnt Head Mozzhp
Check

{I:I\_\ M/ Print Head Cleaning

5&\' Power Cleaning

@
S

'E'ﬁ"-. Print Head Algnment
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5. Select Print Head Alignment.

6. Select one of the following options:
» Vertical Alignment if your printout is blurry or contains vertical ruled lines that are misaligned.
* Horizontal Alignment if your printout contains horizontal banding.

7. Follow the on-screen instructions to print an alignment sheet.

Note: Do not cancel printing while you are printing head alignment patterns.

8. Check the printed patterns on the alignment sheet and select the following on the LCD screen,
depending on the alignment pattern you printed:

» Vertical Alignment: For each set of patterns, select the number representing the pattern with the
least amount of separation or overlap.

#1 4 5

1 6
N M u o

@

* Horizontal Alignment: Select the number representing the pattern with the least amount of
separation or overlap.

1

n

9. Continue following the rest of the on-screen instructions to finish the alignment.
Parent topic: Adjusting Print Quality
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Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Cleaning the Translucent Film

Cleaning the Paper Guide
If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.
1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.

2. Load plain paper into Cassette 2 in one of these sizes: Letter (8.5 x 11 inches [216 x 279 mm]) or A4
(8.3 x 11.7 inches [210 x 297 mm]).

3. Press the 900 home button, if necessary.
4. Select Maintenance.
You see a screen like this:

@ hEaimionanoe

Print Head Mozzle
Check

‘[F\I_‘ ' Print Head Claaning

N\' Power Cleaning

@S

-E_'Lﬁ Print Haad Algnment

5. Scroll down and select Paper Guide Cleaning.

6. Follow the on-screen instructions to clean the paper guide.

7. Repeat these steps as necessary until the paper comes out clean.
If the paper is still smeared with ink, continue with the next steps.
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8. Turn off the product.

9. Unplug the power cord and disconnect it from the product.
10. Disconnect any connected cables.

11. Raise the control panel all the way.

12. Slide out the output tray.
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13. Gently wipe the two white rollers shown here using a soft, moist cloth. Gently rotate the rollers to
clean them completely.

4 )

14. Connect the power cord and any interface cables, and turn your product back on.
Parent topic: Adjusting Print Quality

Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Cleaning the Translucent Film
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Cleaning the Paper Rollers
Cleaning the Translucent Film
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

Close the output tray, front cover, and rear paper feed cover when you are not using the product to
protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

Turn off the product.

Unplug the power cable.

Disconnect any connected cables.

Remove all the paper.

ok~ wbd -~

Open the document cover.
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6. Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with a
little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.

7. Close the document cover.
Clean the outer case and control panel with a soft, moistened cloth.

Caution: Be careful not to get water onto the printer mechanism or any electrical components; doing
so may damage the product.

Parent topic: Cleaning and Transporting Your Product

Cleaning the Paper Rollers

If you encounter issues with paper feeding from the cassettes, clean the paper rollers inside your
product.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
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. Remove the paper cassettes.

Warning: Be careful not to trap your fingers under the product.
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6. Use a soft, moist cloth to clean the cassette rollers shown here. Gently rotate the rollers to clean
them completely.

-

7. Return the product to its normal position.
Caution: Do not leave the product on its side for an extended period of time. Ink may leak.

8. Slide in the paper cassettes, and connect the power cable and any interface cables.
Parent topic: Cleaning and Transporting Your Product

Related tasks
Cleaning the Paper Guide
Cleaning the Translucent Film

Cleaning the Translucent Film

If the print quality has not improved after aligning the print head and cleaning the paper path, the print
head path inside the product may be smeared with ink.

To clean the print head path, use the following:

+ Several cotton swabs

» Yacup (59 ml) water containing 2 to 3 drops of mild dish detergent
* A small flashlight
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Caution: Do not use any other liquid to clean the print head path or you may damage your product.

Turn off the product.
Unplug the power cable.
Disconnect any connected cables.

o Dd =

Lift up the scanner unit.

1 Translucent film
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9.

2 Print head rail (do not touch)

Caution: Do not touch the flat white cable or the print head rail; otherwise, you may not be able to
print. Do not wipe off the grease on the rail.

Moisten a cotton swab with the water and detergent mixture and squeeze out any excess moisture.
Use it to lightly wipe ink off the translucent film.

Caution: Do not press too hard on the film or you may dislocate the anchor springs and damage the
product.

Use a new, dry cotton swab to dry the translucent film.

Caution: Do not leave any cotton fibers on the film.

Repeat steps 6 and 7 as necessary to clean all ink smears.

Note: Replace the cotton swab, as necessary, to prevent any smears from spreading.
When the translucent film is dry and free of any fibers, close the scanner unit.

Note: The scanner unit is designed to close slowly as a precaution against trapping fingers.
Continue to close the scanner unit even if you feel some resistance.
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10. Plug in the power cable and reconnect any interface cables.
Parent topic: Cleaning and Transporting Your Product

Related tasks

Cleaning the Paper Guide

Cleaning the Paper Rollers

Aligning the Print Head Using the Product Control Panel

Transporting Your Product

If you need to store your product or transport it a long distance, prepare it for transportation as described
here.

Caution: During transportation and storage, follow these guidelines:

* Avoid tilting the product or turning it upside down. Also avoid placing the product on its side for an
extended period of time. Ink may leak.

* Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent
the product from printing.

* Do not carry the product by its control panel; this may damage the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.
The control panel and output tray close automatically.
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2. Lift up the scanner unit and check to see if the print head is in the far right position (the home
position). If not, turn on the product, wait for the print head to move, then turn the product off again.
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3. Place the protective material that came with the product on top of the ink cartridge holder as shown
and secure the ink cartridge holder to the case with tape.

4 )

Caution: Do not place tape on the white flat cable inside the product; otherwise, you may damage
your product.

4. Lower the scanner unit.

Note: The scanner unit is designed to close slowly as a precaution against trapping fingers.
Continue to close the scanner unit even if you feel some resistance.

Remove all the paper from the product.
Remove any memory cards or USB devices from the product.
Unplug the power cable.

® N o o

Disconnect any connected cables.
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9. Close all parts on the product as shown.

10. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.

Keep the product level during transportation.

Be sure to remove the tape and protective material from the ink cartridge holder before turning on your
product. If print quality has declined when you print again, clean and align the print head.

Parent topic: Cleaning and Transporting Your Product
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Related concepts

Print Head Nozzle Check
Print Head Cleaning
Power Cleaning

Related tasks
Aligning the Print Head Using the Product Control Panel
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates

Product Status Messages

Viewing the Help Screen

Running a Product Check

Resetting Control Panel Defaults

Solving Setup Problems

Solving Network Problems

Solving Copying Problems

Solving Paper Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Solving Scanning Problems

Solving Scanned Image Quality Problems
Solving Memory Card Problems

Solving USB Device Problems

Solving CD/DVD Problems

Uninstall Your Product Software

Where to Get Help

Checking for Software Updates

It's a good idea to check Epson's support website occasionally for free updates to your product software.
Visit epson.com/support (U.S.) or epson.ca/support (Canada) and select your product.

Note: Your printer is designed to work only with genuine Epson-brand ink cartridges. Other brands of ink
cartridges and ink supplies are not compatible and, even if described as compatible, may not function
properly or at all. Epson periodically provides firmware updates to address issues of security,
performance, minor bug fixes and ensure the printer functions as designed. These updates may affect
the functionality of third-party ink. Non-Epson branded or altered Epson cartridges that functioned prior
to a firmware update may not continue to function.
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* Windows: Your printer software automatically checks for updates. You can also manually update the
software by selecting Software Update here:

» Accessing the Windows Desktop and right-clicking the & icon for your product in the right side of
the Windows taskbar, or clicking the up arrow and right-clicking Bui

+ On the Maintenance tab in the printer settings window

You can also update the software by selecting EPSON Software Updater in the EPSON or Epson
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

» 0OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

* macOS 10.12.x, 10.13.x, 10.14.x, 10.15.x, 11.x, or 12.x: You can manually update the software by
opening the App Store, selecting Updates, searching for a software update option for Epson
Software, and selecting Update.

Parent topic: Solving Problems

Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen. You
can also press the @ help button to see help information and how-to instructions on the screen.

LCD screen message

Condition/solution

An error occurred while
saving. Check and if
necessary, change the
memory device.

The memory card or external USB device may be damaged. Make sure the
memory card or USB device is inserted correctly and meets the
specifications for the product.

Ink is low.

Ink cartridge(s) are low.
Print job may not print
completely.

The ink cartridge is low. You can continue printing until you are prompted to
replace the cartridge. Make sure you have the replacement cartridge ready.

You need to replace the
following ink
cartridge(s).

The ink cartridge is expended. Replace the cartridge.
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LCD screen message

Condition/solution

Cannot recognize ink
cartridge. Select "Next"
to clear the error.

Check that the ink cartridges are installed correctly. Press down on each of
the cartridges gently and make sure they have clicked into place.

If the incorrect ink cartridges are installed, replace them with ink cartridges
compatible with this printer.

Printer error. Turn the
power off and on again.
If the problem persists,
press "Proceed".

A fatal error has occurred. Check for a paper jam or any protective material
inside the product. Clean the translucent film inside the printer if it is smeared
with ink. Then, close the scanner unit and turn the product off and back on
again. If the error continues, contact Epson for support.

Communication error.
Check if the computer is
connected.

Make sure the computer is connected to your product and your software is
installed correctly.

Paper Configuration is
set to Off. Some
features may not be
available. For details,

see your documentation.

The Paper Configuration setting must be enabled to use AirPrint.

The printer's borderless
printing ink pad is
nearing the end of its
service life. It is not a
user-replaceable part.
Please contact Epson
support.

The ink pads are near the end of their service life and the message will be
displayed until the ink pad is replaced. Contact Epson for support. (To
resume printing, select OK.)

The printer's borderless
printing ink pad has
reached the end of its
service life. It is not a
user-replaceable part.
Please contact Epson
support.

The ink pad is at the end of its service life. Turn off the product and contact
Epson for support.

To use cloud services,
update the root
certificate from the
Epson Web Config
utility.

Access your product's built-in Web Config utility and update the root
certificate for your product.
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LCD screen message

Condition/solution

The combination of IP
address and subnet
mask is invalid. See
your documentation for
more details.

There is a problem with the network connection to your product. Check the
solutions in this guide.

Cannot recognize the
media. See your
documentation for more
details about the media.

Cannot use the inserted
Memory Device. See
your documentation for
details.

Make sure the external storage device meets the specifications.

Print Head Adjustment
Canceled. There is a
problem with the print
head. Contact Epson
Support.

If print quality has not improved after running a nozzle check and cleaning
the print head three times, turn off the product and wait at least 12 hours.
Then run a nozzle check and try cleaning the print head again. If print quality
has still not improved, run a Power Cleaning. If it still has not improved after
that, contact Epson for support.

Install the Epson Event
Manager software on
the computer to use this
feature. See your
documentation for more
details.

Make sure Epson Event Manager is installed on your computer.
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LCD screen message

Condition/solution

Check the following if a
computer is not found.

- Connection between
the printer and the
computer (USB or
network)

- Installation of the
necessary software

- Power supply to the
computer

- Firewall and security
software settings

- Search again

See your documentation
for more details.

Make sure your product and computer are properly connected and all
necessary software is installed. Make sure your computer is turned on. You
may need to adjust the settings in your firewall or security software.

Check that the printer
driver is installed on the
computer and that the
port settings for the
printer are correct.

Check that the printer
driver is installed on the
computer and that the
USB port settings for the
printer are correct.

Select Print Queue on the printer driver's Maintenance tab. Check the
Property > Port setting from the Printer menu.

Select USBXXX for a USB connection or EpsonNet Print Port for a network
connection.

Access the following or
see documentation for
details. Select [Dismiss]
after confirming it.

Make sure your smartphone is connected for wireless printing.
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LCD screen message

Condition/solution

Printing is suspended to
avoid printing on
mismatched paper.
Paper size selected on
the paper source setting
doesn't match the paper
loaded in XX.

Make sure the paper loaded in the cassette matches the print settings for the
cassette. Change the paper settings or print settings if necessary.

If you do not want to display this message, select If occurs repeatedly and
block this message.

Printing is suspended to
avoid printing on
mismatched paper.
Paper settings don't
match the paper loaded
in XX.

Make sure the paper loaded in the cassette matches the print settings for the
cassette. Change the paper settings or print settings if necessary.

If you do not want to display this message, select Settings > Guide
Functions > Paper Mismatch > Off.

Paper remains inside
because it is placed
sideways. Place XX size
of paper in the XX.
Press "Complete" to

remove the paper inside.

Load letter-size paper in the rear paper feed slot and select Done. Reload
paper in portrait orientation and center it over the arrow mark at the center of
the rear paper feed slot.

Have you loaded the
following paper in the
XX?

Load paper that matches the print settings in the location indicated, or
change the print settings to match the loaded paper.

To avoid this message, set Settings > Guide Functions > Paper Mismatch
to Off.

Recovery mode

An error has occurred during firmware updating. Connect your product using
a USB cable and try updating the firmware again. If you still receive this error
message, contact Epson for support.

Note: The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages.
During the life of your product it may reach a condition where either satisfactory print quality cannot be
maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your
LCD screen, or lights on the control panel will advise you when these parts need replacing. If this
happens during the standard warranty of the product, the exchange of the product or replacement of the
pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced
by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.
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Note: Your printer is designed to work only with genuine Epson-brand ink cartridges. Other brands of ink
cartridges and ink supplies are not compatible and, even if described as compatible, may not function
properly or at all. Epson periodically provides firmware updates to address issues of security,
performance, minor bug fixes and ensure the printer functions as designed. These updates may affect
the functionality of third-party ink. Non-Epson branded or altered Epson cartridges that functioned prior
to a firmware update may not continue to function.

The included initial cartridges are designed for reliable printer setup and cannot be used as replacement
cartridges or resold. After setup, the remaining ink is available for printing. Yields are based on ISO
24711 in default mode, printing continuously. Yields vary due to print images, settings, and
temperatures. Printing infrequently or primarily with one color reduces yields. All cartridges must be
installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced
cartridges.

Parent topic: Solving Problems

Related concepts
Uninstall Your Product Software
Print Head Nozzle Check

Related references

Where to Get Help

Memory Card Specifications
External USB Device Specifications

Related tasks

Checking for Software Updates

Removing and Installing Ink Cartridges
Replacing the Maintenance Box

Using AirPrint

Cleaning the Translucent Film

Related topics

Loading Paper

Wi-Fi Networking

Solving Paper Problems

Solving Network Problems

Solving Problems Printing from a Computer
Using an External Device with Your Product
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Viewing the Help Screen
You can view troubleshooting or how-to topics on the LCD screen at any time.

1.

2.

Press the @ help button.
You see this screen:

A

Trowbda
Ehoating

How To...

Select an option to view instructional images or animations.

Parent topic: Solving Problems

Running a Product Check

Running a product check helps you determine if your product is operating properly.

1.

a bk w0

Disconnect any interface cables connected to your product.

Make sure there are no errors on the LCD screen and the CD/DVD tray is not loaded.
Load plain paper in Cassette 2.

Press the 90 home button, if necessary.

Select Maintenance.
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You see a screen like this:

9 KA NANoD

Print Head MNaozzie
Chack ﬂ

‘ﬁ:ﬁ‘ {57 Print Head Cleaning () @
IH.‘\'& Power Cleaning (7]
h.'ﬁ. Print Head Alignment () @

6. Select Print Head Nozzle Check.
You see a screen like this:

@ Print Head Nozzie Check

Load Letier/A4d size paper in the
1?:1‘ Casgelle 2 1o Nozzle Check Pattern. @

7. Select Print.
The nozzle pattern prints.
8. Do one of the following, depending on the results of the product check:

+ If the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
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settings. Check the other solutions in this manual or try uninstalling and reinstalling your printer
software.

« If the page prints but the nozzle check pattern has gaps, clean the print head or run a power
cleaning (depending on the results).

+ If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

Uninstall Your Product Software
Print Head Cleaning

Power Cleaning

Related tasks
Loading Paper in Cassette 2 (Lower Cassette)
Aligning the Print Head Using the Product Control Panel

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

1. Press the 9 home button, if necessary.
2. Select Settings > Restore Default Settings.
You see a screen like this:

a Hosione othull Somngs

Metwork Setings

Q All Except Network Settings @

All Satlings
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3. Select one of these options:

* Network Settings: Resets all network settings

» All Except Network Settings: Resets all settings except for network settings

» All Settings: Resets all control panel settings

You see a confirmation screen.
4. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.

Product Does Not Turn On or Off
Noise After Ink Installation
Software Installation Problems

Parent topic: Solving Problems

Product Does Not Turn On or Off

If you cannot turn the product on or off, try these solutions:

* If you cannot turn on your product, make sure the power cord is securely connected and hold down
the power button a little longer.

* If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off
your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Parent topic: Solving Setup Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:

* Ifthe product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Related references
Where to Get Help

285



Software Installation Problems
If you have problems while installing your product software, try these solutions:

Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

Close any other programs, including screen savers and virus protection software, and install your
product software again.

In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your system administrator.

If you are printing over a network, make sure your product is set up properly on the network.

Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network

Product Does Not Appear in Mac Printer Window

Cannot Print Over a Network

Cannot Scan Over a Network

Parent topic: Solving Problems
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Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router.

Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.
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Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

If you cannot connect your product to a device using Wi-Fi Direct, you may have exceeded the
maximum number of devices connected to your product (8). Print a network status sheet or access
Web Config on the browser for your device and check the number of connected devices. If 8 devices
are already connected, disconnect a device by deleting the product's SSID from the Wi-Fi screen of
that device. If fewer than 8 devices are connected, check the accuracy of your other network settings,
move your device closer to your product, and try connecting again.

If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

Parent topic: Solving Network Problems

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

Make sure your product is turned on and connected to your network. Verify the connection using your
product control panel.

Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

Make sure your product is not connected to a guest network.

If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.

2. Windows only: Uninstall your product software.

3. Restart your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router, so note the next step before restarting it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

If you have replaced your router, reinstall your product software to connect to the new router.
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Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

» Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing detection of your device over the network. See your router or access point documentation
for instructions on disabling the Privacy Separator function.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks
Printing a Network Connection Report

Related topics
Wi-Fi Networking

Product Does Not Appear in Mac Printer Window
If your product does not appear in the Mac printer window, try these solutions:
» Turn your product off, wait 30 seconds, then turn it back on again.

* If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon does not appear
on your product's LCD screen, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

+ If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi icon does not appear lit
on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall
your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software
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Cannot Print Over a Network
If you cannot print over a network, try these solutions:

Make sure that your product is turned on.
Make sure you install your product's network software as described in your product documentation.

Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

Make sure your computer and product are both using the same wireless network.

If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point. Avoid placing your product near a microwave oven,
cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router.

Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the ¥ Wi-Fi icon on your
product is not active, repeat the WPS setup process on the product control panel and be sure to
complete it within 2 minutes of pressing the WPS button on your router.

If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi connection icon is not
lit or does not appear on the product's LCD screen, make sure your product software was installed
correctly. If necessary, reinstall your software.
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Parent topic: Solving Network Problems

Related tasks

Enabling Wi-Fi Direct Mode (Simple AP)

Selecting Wireless Network Settings from the Control Panel
Printing a Network Status Sheet

Printing a Network Connection Report

Related topics
Wi-Fi Networking

Cannot Scan Over a Network
If you have problems scanning over a network, try these solutions:

« If you cannot scan from your product control panel, make sure you restarted your computer after
installing the product software. Make sure the Event Manager program is not being blocked by your
firewall or security software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

« If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

 If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few
seconds, and restart it. If Epson Scan 2 cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan 2 again.

» Check the scanner setting and reset the connection if necessary using Epson Scan 2 Utility:

Windows 11: Click , then search for Epson Scan 2 Utility and select it. Make sure your product is
selected. If necessary, select the Other tab and click Reset.

Windows 10: Click ﬂ and select EPSON > Epson Scan 2 Utility. Make sure your product is
selected. If necessary, select the Other tab and click Reset.

Windows 8.x: Navigate to the Apps screen, select EPSON, and select Epson Scan 2 Utility. Make
sure your product is selected. If necessary, select the Other tab and click Reset.
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Windows (other versions): Click E]' or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility. Make sure your product is selected. If necessary, select the Other
tab and click Reset.

Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure your product is selected. If necessary, select the Other tab and click Reset.

* You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Parent topic: Solving Network Problems

Related concepts
Scan Resolution Guidelines

Related tasks

Starting a Scan Using the Product Control Panel
Starting a Scan Using Epson ScanSmart
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smartphone or Tablet

Solving Copying Problems
Check these solutions if you have problems copying with your product.

Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While

Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* Ifthe nozzle check page does not print, but the product's power is on, make sure your product
software is installed correctly.

» Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems
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Related concepts
Print Head Nozzle Check
Print Head Cleaning

Product Makes Noise When It Sits for a While

Your product is performing routine maintenance. This is normal.

Parent topic: Solving Copying Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.

Paper Feeding Problems

Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Rear Cover
Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:

Place the product on a flat surface and operate it in the recommended environmental conditions.
Be sure to insert the paper cassette all the way into your product.

If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
Do not load more than the recommended number of sheets.

Make sure your paper meets the specifications for your product.

If paper jams when you print on both sides of the paper, try loading fewer sheets.

Clean the roller inside the printer to remove any dust on the paper path.

For best results, follow these guidelines:

» Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.

» Load paper in the cassette printable side down.

» Follow any special loading instructions that came with the paper.
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Parent topic: Solving Paper Problems

Related references

Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Rear Cover
Paper Specifications

Paper Loading Capacity

Related tasks

Cleaning the Paper Guide

Paper Jam Problems Inside the Product

If you see a message that paper has jammed inside the product, follow the steps here or on the LCD
screen to clear the jam.

1. Cancel the print job, if necessary.
2. Remove any jammed paper from the rear paper feed slot.
3. Lift the scanner unit.
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4. Remove any jammed paper inside the product.

Caution: Do not touch the flat white cable or the metal bar inside your product.
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5. Close the scanner unit.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems in the Rear Cover
Paper Jam Problems in the Paper Cassette

Related tasks
Cancelling Printing Using a Product Button

Paper Jam Problems in the Paper Cassette

If you see a message that paper has jammed in the paper cassette, follow the steps here or on the LCD
screen to clear the jam.

1. Cancel the print job, if necessary.
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2. Remove both paper cassettes.

Note: To remove the bottom cassette (Cassette 2), lift the cassette slightly before pulling it out.

3. Remove any jammed paper.
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4. Make sure the paper is loaded under the edge guides.

5. Keep the cassettes flat as you insert them.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems
Related references

Paper Jam Problems Inside the Product
Paper Jam Problems in the Rear Cover
Paper Jam Problems in the Paper Cassette
Paper Specifications

Paper Feeding Problems

Paper Ejection Problems

Related tasks

Cancelling Printing Using a Product Button

Paper Jam Problems in the Rear Cover

If you see a message that paper has jammed in the rear cover, follow the steps here or on the LCD
screen to clear the jam.

1. Cancel the print job, if necessary.
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2. Press the buttons to release the rear cover and remove it from your product.

3. Carefully remove any jammed paper from inside the product.

e

4. Remove any jammed paper from inside the rear cover.

5. Reattach the rear cover.
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6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems
Related references

Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette

Related tasks
Cancelling Printing Using a Product Button

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

« If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.
Select the correct paper size when you reprint.

« If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting when you reprint.

+ Clean the roller inside the printer to remove any dust on the paper path.
Parent topic: Solving Paper Problems

Related references

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Rear Cover

Paper Loading Capacity

Paper Specifications

Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printer Software
Related tasks

Selecting the Paper Settings for Each Source - Control Panel
Cancelling Printing Using a Product Button
Cleaning the Paper Guide

Related topics
Loading Paper
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Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow

Parent topic: Solving Problems

Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

Make sure your product is turned on and connected to your computer.
Make sure any interface cables are connected securely at both ends.

If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

Make sure the printer status is not offline or pending.

Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. Print the image at a lower
resolution or if necessary, increase your system's memory.

In Windows, make sure your product is selected as the default printer and the printer port setting
matches the printer connection port.

In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

On a Mac, make sure the printer is added to the printer list and the printer is not paused.
Make sure your product is selected as the printer in your printing program.

Parent topic: Solving Problems Printing from a Computer

Related references
Product Status Messages
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Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:

No o bk oD

Windows 11: Click , search for Settings and select it. Select Devices > Printers & scanners.
Select your product name and select Printing preferences.

Windows 10: Click Bl and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select Printing Preferences, and select
your product name again if necessary.

Windows 7: Click E]' and select Devices and Printers. Right-click your product name, select
Printing Preferences, and select your product name again if necessary.

Windows Vista: Click E]' select Control Panel, and click Printer under Hardware and Sound.
Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Maintenance tab.

Click the Extended Settings button.

Select Enable EPSON Status Monitor 3 and click OK.

Click the Monitoring Preferences button.

Click the checkbox for the option that adds the shortcut icon to the taskbar.
Click OK to close the open program windows.

Parent topic: Solving Problems Printing from a Computer

302



Printing is Slow
If printing becomes slow, try these solutions:

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

If you are using Windows 7, close the Devices and Printers window before you print.
On a Mac, make sure you download and install the Epson printer driver.

Make sure Quiet Mode is turned off.

Clear space on your hard drive or run a defragmentation utility to free up existing space.
Close any programs you are not using when you print.

If your product is connected to a USB hub, connect it directly to your computer instead.

If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

If you are printing over a wireless network, factors such as interference, network traffic, or weak signal
strength may affect your printing speed.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

If you are printing photos on plain paper, print speed may be reduced to maintain image quality.

For the fastest printing, select the following settings in your product software:

Make sure the paper type setting matches the type of paper you loaded.
Turn on any high speed settings in your product software.
Select a lower print quality setting.

Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,
and select the following settings:

» Always Spool RAW Datatype
* Page Rendering Mode
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* Print as Bitmap

» Enable the bidirectional setting on the product control panel (Settings > Printer Settings >
Bidirectional).

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click EI' and select Computer or My Computer. Double-click the C: drive and open these folders:
ProgramData > EPSON > PRINTER.

Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and
search options. In the window that appears, click the View tab, select Show hidden files, folders,
and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDFO01.AUD file and select Delete.
3. Restart your computer and try printing again.

Parent topic: Solving Problems Printing from a Computer
Related references

Windows System Requirements

Mac System Requirements

Paper or Media Type Settings - Printer Software
Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac

Selecting Printing Preferences - Mac

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image
Too Many Copies Print
Blank Pages Print
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Incorrect Margins on Printout

Border Appears on Borderless Prints
Incorrect Characters Print

Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
» Turn off any mirror or inversion settings in your printing application.

» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer
software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Additional Layout and Print Options - Windows
Selecting Print Layout Options - Mac

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - Mac

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.

+ If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software, if available.
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Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.

Make sure your product is selected as the printer in your printing program.

Make sure your product is on a flat surface and operating in the recommended environmental
conditions or multiple sheets of paper may be fed at the same time.

Parent topic: Solving Page Layout and Content Problems

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:

Make sure you selected the correct paper size settings in your printing program and printer software.
Make sure you selected the correct margins for your paper size in your printing program.
Make sure your paper is positioned correctly for feeding into the product.

When placing originals on the scanner glass, align the corner of the original with the corner indicated
by the arrow. If the edges of the copy are cropped, move the original slightly away from the corner.

Clean the scanner glass and the document cover. If there is dust or stains on the glass, the copy area
may extend to include the dust or stains.

Load paper in the correct direction and slide the edge guides against the edges of the paper.
Select the appropriate original size in the copy settings.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:

Make sure you are printing on a compatible borderless paper type and size.
Note: For custom paper sizes, make sure you select a supported borderless page width.

Windows: Make sure you selected the Borderless setting in your printer software.

Mac: Make sure you selected the Borderless checkbox or a paper size with a Borderless option in
your printer software.

Adjust the Expansion setting to adjust the amount of image expansion on the edges of borderless
prints.
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Make sure the image size and the paper size are set correctly; if the image is small, the enlargement
may not be enough to cover the paper.

Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Extended Settings - Windows
Selecting Printing Preferences - Mac
Printing Your Document or Photo - Mac
Printing Your Document - Windows

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:

Make sure any cables are securely connected at both ends.

In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

If your product is connected to a USB hub, connect it directly to your computer instead.
If incorrect characters still appear in your prints, try connecting your product using a different cable.

If your computer entered sleep mode the last time you printed, the next print job after your computer
exits sleep mode may contain garbled characters. Print your document again.

Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

Make sure you selected the correct paper size on the control panel.
Make sure your paper is positioned correctly for feeding into the printer.
Slide the edge guides against the edges of the paper.

If the edges of a copy are cropped, slightly move the original away from the edges of the scanner
glass.

Make sure you selected the correct margins for your paper size in your printing program.
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» Be sure to select the appropriate original size setting for your original in the copy settings.

+ If the image is slightly enlarged and cropped during borderless printing, change the Expansion
setting.

You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Placing Originals on the Scanner Glass
Selecting Page Setup Settings - Mac
Cleaning Your Product

Related topics
Loading Paper

Slanted Printout
If your printouts are slanted, try these solutions:
» Make sure the paper is loaded in the correct direction.
» Make sure your paper meets the specifications for your product.
* Do not load more than the recommended number of sheets.
+ Slide the edge guides against the edges of the paper.
* Make sure the paper type setting matches the type of paper you loaded.
» Select a higher print quality setting in your printer software.
» Turn off any high speed settings in your product software.
+ Align the print head.
» Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - Mac

Aligning the Print Head Using the Product Control Panel
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Related topics
Loading Paper

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout

Faint Printout or Printout Has Gaps
Grainy Printout

Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* Make sure the paper type setting matches the type of paper you loaded.

» Make sure you loaded the printable side of the paper correctly for your product.
» Turn off any high speed settings in your product software.

+ Align the print head.

* Adjust the print quality in the product software.

* If you continue to see horizontal or vertical bands or streaks in your printouts after cleaning and
aligning the print head, you can finely tune the horizontal or vertical alignment in the Maintenance
menu.

* You may need to replace the ink cartridges.
Parent topic: Solving Print Quality Problems

Related references
Paper or Media Type Settings - Printer Software
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Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printer Software

Related tasks

Selecting Basic Print Settings - Windows

Selecting Additional Layout and Print Options - Windows
Selecting Extended Settings - Windows

Selecting Basic Print Settings - Mac

Selecting Print Layout Options - Mac

Selecting Printing Preferences - Mac

Replacing the Maintenance Box

Removing and Installing Ink Cartridges

Selecting the Paper Settings for Each Source - Control Panel
Selecting the Paper Settings for Each Source - Control Panel
Aligning the Print Head Using the Product Control Panel

Related topics
Loading Paper

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
+ Slide the edge guides to the edges of the paper.
» Use a support sheet with special paper, or load special paper one sheet at a time.
» Place a piece of black paper on the back of the original and copy it again.
* Make sure your paper meets the specifications for your product.
» Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
» Make sure the paper type setting in your product software matches the type of paper you loaded.
* Make sure you loaded the printable side of the paper correctly for your product.

« If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel
or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this
setting on will decrease print speed.)

* When manually printing 2-sided, make sure the ink is completely dry before loading the paper.
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* Remove each sheet from the output tray as it is printed.
* Avoid handling printouts on glossy paper right after printing to allow the ink to set.

» Dry printouts completely before filing or displaying them. When drying printouts, avoid direct sunlight,
do not use a dryer, and do not touch the printed side of the paper.

» Turn off any high speed settings in your product software.

« If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Make sure the ink has dried before reloading the paper to print on the other side. Adjust the density
and/or ink drying time settings.

» Lower the copy density setting on the product control panel.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

+ Align the print head.
» Adjust the print quality in the product software.
* Clean the paper path.

* Do not press too hard on the original or the document cover when you are scanning originals on the
scanner glass.

* Clean the scanner glass.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Maintenance

Related references

Paper Specifications

Related tasks

Selecting Double-sided Printing Settings - Windows
Selecting Double-sided Printing Settings - Mac
Cleaning the Translucent Film

Selecting Basic Print Settings - Windows
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Selecting Basic Print Settings - Mac

Selecting Print Layout Options - Mac

Selecting Additional Layout and Print Options - Windows
Aligning the Print Head Using the Product Control Panel

Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» The ink cartridges may be old or low on ink, and you may need to replace them.

* Make sure the paper type setting matches the type of paper you loaded.

» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
* Align the print head.

+ Adjust the print quality in the product software.

* Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Maintenance

Related tasks

Cleaning the Translucent Film
Removing and Installing Ink Cartridges
Replacing the Maintenance Box
Cleaning the Paper Guide

Related topics
Loading Paper

Grainy Printout
If your printouts are grainy, try these solutions:
» Make sure you loaded the printable side of the paper correctly for your product.
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Select a higher print quality setting and turn off any high speed settings in your product software.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.
Adjust the print quality in the product software.

You may need to increase the image resolution or print a smaller size; see your software
documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

If you enlarged the image size in an image-editing program, you need to increase the image resolution
setting to retain a high image quality. Increase the image resolution by the same amount you increase
the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the
image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageabile.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Maintenance

Related references

Paper or Media Type Settings - Printer Software

Related tasks

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - Mac

Aligning the Print Head Using the Product Control Panel

Removing and Installing Ink Cartridges

Related topics
Loading Paper
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Incorrect Colors
If your printouts have incorrect colors, try these solutions:
* Make sure the paper type setting matches the paper you loaded.
» Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

+ Theink cartridges may be old or low on ink, and you may need to replace them.

+ After you print, the colors in your printout need time to set as the ink dries. During this time, the colors
may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.

* Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

» Try selecting a different Color Management setting on the More Options tab of the printer software,
and changing the Scene Correction setting to something other than Auto Correct.

» For best results, use genuine Epson paper.

» On the product control panel, change the Fix Photo setting from Auto to another option, or select
Enhance Off.

Parent topic: Solving Print Quality Problems

Related tasks

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - Mac

Selecting Additional Layout and Print Options - Windows
Managing Color - Mac

Replacing the Maintenance Box

Removing and Installing Ink Cartridges

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.

Note: For solutions when using the Epson ScanSmart software, see the Epson ScanSmart help utility.
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Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Scanning is Slow

Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:

Make sure your computer has adequate memory and meets the system requirements for your
operating system.

Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart your scanning software.

If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.

In Windows, make sure your product is listed as a valid device in the Scanners and Cameras control
panel.

Try scanning at a lower resolution or increase the free space on the computer's hard disk. Scanning
stops if the total data size reaches the limit.

Use the Epson Scan 2 Utility on your computer to reset the scanner software settings. If resetting the
settings does not solve the problem, uninstall and reinstall the scanner software.

Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2

If you cannot start Epson Scan 2, try these solutions:

Make sure your product is turned on and any interface cables are securely connected at both ends.
If your product is connected to a USB hub, connect it directly to your computer instead.

If you scan at a high resolution over a network, a communication error may occur. Lower the
resolution.

Make sure Epson Scan 2 is selected as your scanning program.
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* Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart Epson Scan 2.

» Check the connection setting and test the connection using Epson Scan 2 Utility:

Windows 11: Click , search for Epson Scan 2 Utility and select it. Make sure the correct product
is selected. If necessary, select the Other tab and click Reset.

Windows 10: Click ﬂ and select EPSON > Epson Scan 2 Utility. Make sure the correct product is
selected. If necessary, select the Other tab and click Reset.

Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility. Make sure the correct
product is selected. If necessary, select the Other tab and click Reset.

Windows (other versions): Click E]' or Start > All Programs or Programs > EPSON > Epson Scan
2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other
tab and click Reset.

Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure the correct product is selected. If necessary, select the Other tab and click Reset.

» Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both
versions and install one version.

« If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software
Scan Resolution Guidelines

Related references
Additional Scanning Settings - Advanced Settings Tab

Related tasks
Starting a Scan from a Scanning Program
Scanning in Epson Scan 2

Scanning is Slow
If scanning becomes slow, try these solutions:
» Scan your original at a lower resolution, if possible.
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* Make sure your system meets the requirements for your operating system. If you are scanning a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory or reduce the resolution.

* In Epson Scan 2, open the Configuration screen and turn off Quiet Mode on the Scan tab.
» The scanning speed may be reduced depending on the image adjustment features in Epson Scan 2.

+ If you are scanning over a network, factors such as interference, network traffic, or weak signal
strength may affect your scanning speed.

Parent topic: Solving Scanning Problems

Related concepts
Scan Resolution Guidelines

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Note: For solutions when using the Epson ScanSmart software, see the Epson ScanSmart help utility.

Scanned Image Quality Problems

Image Consists of a Few Dots Only

Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
Image Colors are Patchy at the Edges
Ripple Patterns Appear in an Image
Scanned Image Edges are Cropped

Parent topic: Solving Problems

Scanned Image Quality Problems
If you encounter quality problems with your scanned image, try these solutions:

Image is Distorted or Blurry

» Make sure your original is not wrinkled or warped. This may prevent the original from laying flat when
passed over the scanner sensors.

* Do not move your original or your product during scanning.
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* Your product will not operate properly while tilted at an angle. Place your product on a flat, stable
surface that extends beyond its base in all directions.

» Adjust these Epson Scan 2 or Epson ScanSmart settings (if available) and try scanning again:
* Increase the Resolution setting.
+ If the Image Type setting is Black & White, adjust the Threshold setting.
+ If the Image Type setting is Color or Grayscale, select the Unsharp Mask setting.
+ Ifthe Image Type setting is Black & White, select Text Enhancement. If the Image Type setting is
Color or Grayscale, change the Text Enhancement setting to High.
Image is Too Dark
« Ifthe Image Type is set to Color or Grayscale, adjust the Brightness setting.
» Check the brightness and contrast settings of your computer monitor.

Back of Original Image Appears in Scanned Image
» Place a piece of black paper on the back of the original and scan it again.
» Adjust these Epson Scan 2 or Epson ScanSmart settings (if available) and try scanning again:
+ Select the Advanced Settings tab and adjust the Brightness setting.
+ Ifthe Image Type is set to Black & White, select Text Enhancement. If the Image Type is set to
Color or Grayscale, change the Text Enhancement setting to High.
Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan 2 or Epson ScanSmart settings (if
available) and try scanning again:

+ If the Image Type setting is Color or Grayscale, adjust the Contrast setting.
« Ifthe Image Type setting is Black & White or Grayscale, adjust the Color Enhance setting.
Parent topic: Solving Scanned Image Quality Problems
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Related tasks
Scanning a Document in Epson ScanSmart
Scanning in Epson Scan 2

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
» Make sure you placed your original for scanning facing the correct way.
+ If the Image Type setting is Black & White, adjust the Threshold and scan again.
* Remove any lint or dirt from your original.
* Clean the scanner glass.
* Do not press on the original or the document cover with too much force.
Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Your Product

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, try these solutions:

» Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the
cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

* Make sure any interface cables are securely connected at both ends.

* Remove any dust or dirt that may have adhered to your original.

» Keep the document cover closed to prevent dirt or dust from getting inside.
Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Your Product
Placing Originals on the Scanner Glass
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Straight Lines in an Image Appear Crooked

If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Placing Originals on the Scanner Glass

Image Colors are Patchy at the Edges

If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.

Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:

» Select the Descreening setting on the Advanced Settings tab.
» Select a lower Resolution setting.

» Place the original at a slightly different angle.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Scanning in Epson Scan 2
Scanning a Document in Epson ScanSmart

Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.

Parent topic: Solving Scanned Image Quality Problems

Solving Memory Card Problems
Check these solutions if you have problems using memory cards with your product.
Memory Card Does Not Fit Into a Slot
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Cannot View or Print Photos from a Memory Card or Device
Cannot Transfer Photos to or from a Memory Card or Device

Parent topic: Solving Problems

Memory Card Does Not Fit Into a Slot

If a memory card does not fit properly in a slot, do not force it in. You may need to use an adapter with
your memory card.

Parent topic: Solving Memory Card Problems

Related references
Memory Card Specifications

Related tasks
Inserting a Memory Card

Cannot View or Print Photos from a Memory Card or Device

If you cannot view or print photos from a memory card or USB device inserted in your product, try these
solutions:

» Make sure your memory card or device is compatible with the product.
» Make sure the files on your memory card or device are in the correct format.

« If you have too many photos on your memory card or device, you may not see all the photos you
expect or may be prompted to select a group of photos by date. Reduce the number of photos on your
card or select one group of photos at a time. Check the specifications for the maximum number of
photos.

Parent topic: Solving Memory Card Problems

Related references

Memory Card Specifications

External USB Device Specifications

Related tasks

Connecting and Printing from a Camera

Related topics

Viewing and Printing Photos

Viewing or Printing from a USB Flash Drive or External Device
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Cannot Transfer Photos to or from a Memory Card or Device

If you have problems transferring photos to or from a memory card or USB device inserted in your
product, try these solutions:

* Make sure your memory card or device is compatible with the product.
» Make sure your product is securely connected to your computer.

* If you are transferring photos to a memory card, check the memory card's write-protect tab to make
sure it is set to allow writing to the card.

* Make sure that the file sharing setting for your product is set correctly.
Parent topic: Solving Memory Card Problems

Related references
Memory Card Specifications
External USB Device Specifications

Related tasks
Setting Up File Sharing for Photo Transfers from Your Computer
Transferring Photos from a Memory Card to Your Computer

Solving USB Device Problems
Check these solutions if you have problems using USB devices with your product.

Cannot View or Print from a USB Device
Cannot Save Files on a USB Device
Cannot Transfer Files To or From a USB Device

Parent topic: Solving Problems

Cannot View or Print from a USB Device

If you cannot view or print photos or documents from a USB device connected to your product, try these
solutions:

* Make sure memory devices are enabled on the product.

» Make sure your device is compatible with the product.

* Make sure the files on your device are in the correct format.

 If you see an exclamation point on the photo selection screen, the image file format is not supported.
Parent topic: Solving USB Device Problems
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Cannot Save Files on a USB Device
If you cannot save files on a USB device connected to your product, try these solutions:
» Make sure the device is not write-protected.
» Make sure the device has enough available space.
* Make sure memory devices are enabled on your product.
* Make sure the device is compatible with the product.
Parent topic: Solving USB Device Problems

Cannot Transfer Files To or From a USB Device

If you have problems transferring files to or from a USB device connected to your product, try these
solutions:

» Make sure your device is compatible with the product.

» Make sure the device is not write-protected.

» Make sure there is enough free space on the device.

» Make sure your product is securely connected to your computer.
* Make sure that the file sharing setting for your product is enabled.
Parent topic: Solving USB Device Problems

Solving CD/DVD Problems

Check these sections if you have problems printing on a CD/DVD with your product.
Problems Printing on CDs/DVDs
Parent topic: Solving Problems

Problems Printing on CDs/DVDs

If you encounter CD/DVD printing problems, try these solutions:

Ink Smears on CD/DVD
» Make sure you are printing on ink jet-printable CDs or DVDs and that the surface of the disc is dry.
* Handle printed discs carefully and let them dry for 24 hours before inserting them in a drive.

» Adjust the print quality using the Epson Print CD software. See the Epson Print CD help utility for
details.
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CD/DVD Jam Problems

If a CD/DVD has jammed in the product and you see an error message, you need to remove the
CD/DVD tray:

1. Cancel the print job from your computer, if necessary.

Slowly pull the CD/DVD tray out of the product.

Clear the error message.

If an error is still displayed, turn off the product, wait a moment, and then turn it back on.

L S

If you are unable to remove the CD/DVD tray, contact Epson for support.

Image Not Centered on CD/DVD

* If you are printing from a computer, adjust the print position using the Epson Print CD software. See
the Epson Print CD help utility for details.

« If you are printing from the control panel, adjust the printing position using the product menus.

Faint Image on CD/DVD

If your printed image is faint, adjust the print quality using the Epson Print CD software. See the Epson
Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Related tasks
Cancelling Printing Using a Product Button

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Close any open programs or applications.
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Disconnect any interface cables.
Do one of the following:

* Windows 11: Click , then search for Settings and select it. Select Apps or System > Apps &
features. Then select the program you want to uninstall and select Uninstall.

* Windows 10: Click E and select k=4 (Settings) > Apps or System > Apps & features. Then
select the program you want to uninstall and select Uninstall.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
* Windows 11/Windows 10/8.x: Select Epson Event Manager and click Uninstall.

* Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and
Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:

* Windows 11/Windows 10: Select Epson Scan and click Uninstall.

* Windows 8.x/Windows 7/Windows Vista: Select Epson Scan 2 and click Uninstall/Change.
Do one of the following to uninstall Epson ScanSmart, then follow any on-screen instructions:

* Windows 11/Windows 10: Select Epson ScanSmart and click Uninstall.

* Windows 8.x/Windows 7/Windows Vista: Select Epson ScanSmart and click
Uninstall/Change.

Restart your computer, then see the Start Here sheet to re-install your software.
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Note: If you find that re-installing your product software does not solve a problem, contact Epson.
Parent topic: Uninstall Your Product Software

Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com/support (U.S.) or epson.ca/support (Canada) and
select your product.

Click Downloads.

Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.
Run the file you downloaded.

Double-click the Uninstaller icon.

o ok wbd

In the Epson Uninstaller screen, select the checkbox for each software program you want to
uninstall.

Click Uninstall.
8. Follow the on-screen instructions to uninstall the software.

~

Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the — (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.
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http://www.epson.ca/support

Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) and select
your product for solutions to common problems. You can download drivers and documentation, get
FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

+ U.S.: (562) 276-4382, 7 AM to 4 PM, Pacific Time, Monday through Friday

» Canada: (905) 709-3839, 7 AM to 4 PM, Pacific Time, Monday through Friday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at epson.com (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements

Paper Specifications

Printable Area Specifications
Scanning Specifications

Memory Card Specifications

Ink Cartridge Specifications
Dimension Specifications

Electrical Specifications
Environmental Specifications
Interface Specifications

External USB Device Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 11

* Windows 10

* Windows 8.x
* Windows 7

* Windows Vista

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.) or epson.ca/support (Canada), select your product, and select Downloads.
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Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
*+ macOS 12.x
*+ macOS 11.x
* macOS 10.15.x
*+ macOS 10.14.x
*+ macOS 10.13.x
* macOS 10.12.x
+ OSX10.11.x
+ OS X10.10.x
+ OS X 10.9.x

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.) or epson.ca/support (Canada), select your product, and select Downloads.

Parent topic: Technical Specifications
Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.
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Single-sheets

Size

Paper types

Weight
Envelopes

Size
Paper types
Weight

A4 (8.3 x 11.7 inches [210 x 297 mm])

A6 (4.1 x 5.8 inches [105 x 148 mm)])

Letter (8.5 x 11 inches [216 x 279 mm])
Legal (8.5 x 14 inches [216 x 356 mm])

4 x 6 inches (102 x 152 mm)

5 x 7 inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

3.5 x 5inches (89 x 127 mm)

16:9 wide (4 x 7.1 inches [102 x 181 mm])
Half Letter (5.5 x 8.5 inches [140 x 216 mm])
8.5 x 13 inches (216 x 330 mm)

Plain paper

Note: Your product also supports compatible papers distributed by

Epson. See the link at the end of this topic for a list of compatible
Epson papers.

Plain paper: 17 Ib (64 g/m?) to 24 |b (90 g/m?)

No. 10 (4.1 x 9.5 inches [105 x 241 mm])
Plain paper
20 Ib (75 g/m?) to 27 Ib (100 g/m?)

Parent topic: Technical Specifications

Related references
Available Epson Papers

Borderless Paper Type Compatibility
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Printable Area Specifications
Note: When printing borderless, quality may decline in the expanded printable area.

Single sheets - borders

. -

- —

1 Top/bottom/left/right margins: 0.12 inch (3 mm) minimum
2  Reduced print quality area/top: 1.61 inches (41 mm) minimum
3 Reduced print quality area/bottom: 1.46 inches (37 mm) minimum

Single sheets - borderless

000,

D220
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1 Reduced print quality area/top: 1.73 inches (44 mm) minimum
2 Reduced print quality area/bottom: 1.57 inches (40 mm) minimum

Envelopes
—1'7// I—
;
_ \| —
i T
1 Right/left margins: 0.12 inch (3 mm) minimum
2 Top/bottom margins: 0.2 inch (5 mm) minimum
3  Reduced print quality area/right: 0.71 inch (18 mm) minimum
4  Reduced print quality area/left: 1.61 inches (41 mm) minimum

CD/DVD

N/
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Minimum inner margin: 0.71 inch (18 mm)

Inner reduced print quality area: 1.69 inches (43 mm)
Outer reduced print quality area: 4.57 inches (116 mm)
Maximum outer margin: 4.72 inches (120 mm)

Parent topic: Technical Specifications

Scanning Specifications

Scanner type
Photoelectric device
Document size

Scanning resolution

Image data

Light source

Flatbed, color

CIS

Maximum: 8.5 x 11.7 inches (216 x 297 mm)

Scanner glass: US letter or A4

1200 dpi (main scan)

4800 dpi (sub scan)

Color:

48 bits per pixel internal (16 bits per pixel per color internal)
24 bits per pixel external (8 bits per pixel per color internal)
Grayscale:

16 bits per pixel internal

8 bits per pixel external

Black and white:

16 bits per pixel internal

1 bit per pixel external

LED

Parent topic: Technical Specifications

Memory Card Specifications

You can insert these types of memory cards in your product.
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Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.

Compatible types/maximum SD (2 GB)

capacity SDHC (32 GB)
SDXC (64 GB)
miniSD* (2 GB)
miniSDHC* (32 GB)
microSD* (2 GB)
microSDHC* (32 GB)
microSDXC* (64 GB)

Media format DCF DCF (Design rule for Camera File system) version 1.0 or 2.0
compliant

You can insert memory cards in your product containing files that meet these specifications.

File format JPEG with the EXxif version 2.31 standard taken with digital camera
using DCF (Design rule for Camera File system) version 1.0 or 2.0
compliant

Image size 80 x 80 pixels to 10200 x 10200 pixels

File size Upto2 GB

Number of files Up to 9990

Note: DCF 2.0 files stored in a camera's built-in memory are not supported.

Parent topic: Technical Specifications
Ink Cartridge Specifications

Note: Your printer is designed to work only with genuine Epson-brand ink cartridges. Other brands of ink
cartridges and ink supplies are not compatible and, even if described as compatible, may not function
properly or at all. Epson periodically provides firmware updates to address issues of security,
performance, minor bug fixes and ensure the printer functions as designed. These updates may affect
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the functionality of third-party ink. Non-Epson branded or altered Epson cartridges that functioned prior
to a firmware update may not continue to function.

The included initial cartridges are designed for reliable printer setup and cannot be used as replacement
cartridges or resold. After setup, the remaining ink is available for printing. Yields are based on ISO
24711 in default mode, printing continuously. Yields vary due to print images, settings, and
temperatures. Printing infrequently or primarily with one color reduces yields. All cartridges must be
installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced

cartridges.
Color Cyan, Light Cyan, Magenta, Light Magenta, Yellow, Black
Cartridge life Opened package: 6 months
Unopened package: do not use if the date on the package has
expired
Temperature Storage: —22 to 104 °F (=30 to 40 °C)

1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (—16 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Dimension Specifications

Height Stored: 5.6 inches (142 mm)
Printing: 7.2 inches (184 mm)

Width Stored: 13.7 inches (349 mm)
Printing: 13.7 inches (349 mm)

Depth Stored: 13.4 inches (340 mm)

Printing: 20.7 inches (527 mm)
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Weight Approximately 15 Ib (6.8 kg)

(without ink cartridges, power
cord, or CD/DVD tray)

Parent topic: Technical Specifications

Electrical Specifications

Power supply rating 100to 120 V

Input voltage range 90to 132V

Rated frequency range 50/60 Hz

Input frequency range 49.5/60.5 Hz

Rated current 06 A

Power consumption Standalone copying: 20 W (ISO/IEC24712)

Ready mode: 7.2 W
Sleep mode: 0.7 W
Power off mode: 0.1 W

Parent topic: Technical Specifications
Environmental Specifications

Temperature Operating: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 104 °F (=20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH

(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications
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Interface Specifications

Interface type Hi-Speed USB (Device Class for computers)
Hi-Speed USB (for Mass storage class for external storage)

Note: Epson cannot guarantee the operation of externally connected devices. USB 3.0 cables are not
supported.

Parent topic: Technical Specifications

External USB Device Specifications
Do not use devices with the following requirements:
» Dedicated driver
» Security settings, such as password or encryption, etc.
* Built-in USB hub

Note: Use only external storage devices with independent AC power sources. External storage devices
that are powered via USB are not recommended. Epson cannot guarantee the operation of externally
connected devices.

CD-ROM/CD-R drive* 700MB maximum capacity
CD-RW is not supported

DVD-ROM/DVD-R drive* 4.7GB maximum capacity
DVD-RW, DVD+R, DVD+RW, DVD-RAM, and Blu-ray Disc are not
supported

Hard disk and USB flash 2TB

drives® Formatted in FAT, FAT32, or exFAT.

Multi-card reader Only insert one card at a time. Multi-card readers with more than two

memory cards inserted are not supported.

* Read-only.
Parent topic: Technical Specifications
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Network Interface Specifications

Standard

Security

Frequency band
Connection modes

Security

Security protocol

IEEE 802.11 b/g/n; IEEE 802.11n available only on the 20 MHz
channel

WPA-PSK (TKIP/AES); complies with WPA2 with support for
WPA/WPA2 Personal

WEP (64/128 bit); not support for Wi-Fi Direct mode
WPAS3-SAE (AES); not supported for Wi-Fi Direct mode
2.4 GHz

Infrastructure mode

Wi-Fi Direct (Simple AP); not supported for IEEE 802.11b

Note: Infrastructure and Wi-Fi Direct modes can be used
simultaneously.

SSL/TLS: HTTPS Server/Client, IPPS
SNMPv3

Parent topic: Technical Specifications

Safety and Approvals Specifications

United States

Canada

Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Safety: CAN/CSA C22.2 No. 60950-1
EMC: CAN ICES-3 (B)/NMB-3 (B)

This equipment contains the following wireless module:

» Manufacturer: Seiko Epson Corporation

- Type: J26H006
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This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions

Important Privacy Notice (Printer Serial Number)
FCC Compliance Statement

Binding Arbitration and Class Waiver
Trademarks

Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.

General Product Safety Instructions

Ink Cartridge Safety Instructions
Wireless Connection Safety Instructions
LCD Screen Safety Instructions

Parent topic: Notices

General Product Safety Instructions
* Be sure to follow all warnings and instructions marked on the product.
» Use only the type of power source indicated on the product's label.

* Use only the power cord that comes with the product. Use of another cord may cause fires or shock.
Do not use the cord with any other equipment.

* Make sure the AC power cord meets the relevant local safety standard.
» Place the product near a wall outlet where the plug can be easily unplugged.

» Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system
that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
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Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,
crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.

If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.

If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

Place the product on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Allow space behind the product for the cables, and space above the product so that you can fully raise
the document cover.

Leave enough space in front of the product for the paper to be fully ejected.

Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place or store the product outdoors.

Do not place the product near excessive heat sources or in direct sunlight.

Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the product away from potential sources of electromagnetic interference, such as loudspeakers
or the base units of cordless telephones.

Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your
product's radio waves from affecting the operation of the pacemaker.

When connecting the product to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

Do not sit or lean on the product. Do not place heavy objects on the product.
Do not touch the flat white cable inside the product.

Do not touch the translucent film inside the product.

Do not move the print head by hand; this may damage the product.

Do not put your hand inside the product while it is printing.
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* Do not spill liquid on the product or use the product with wet hands.

» Do not use aerosol products that contain flammable gases inside or around the product. Doing so may
cause fire.

* Do not press too hard on the scanner glass when placing originals.

» Do not open the scanner section while the product is copying, printing, scanning, or performing any
other functions.

» Be careful not to trap your fingers when closing the scanner unit.

» Except as specifically explained in your documentation, do not attempt to service or disassemble the
product yourself.

* Unplug the product and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

* Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may
prevent the product from printing.

» Before transporting the product, make sure that the print head is in the home (far right) position and
the ink cartridges are in place.

* When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;
otherwise, ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions
» Keep ink cartridges out of the reach of children and do not drink the ink.
» Keep the maintenance box out of the reach of children.

* Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply
port. If ink gets on your skin, wash it off thoroughly with soap and water. If it gets in your eyes, flush
them immediately with water. If discomfort or vision problems persist, see a doctor immediately. If ink
gets in your mouth, see a doctor immediately.

+ Do not put your hand inside the product or touch any cartridges during printing.

» Do not allow dust or foreign objects to get inside the ink cartridge holder or you may not be able to
print. Carefully remove any dust or foreign objects from the holder before installing ink cartridges and
printing.
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+ Install a new ink cartridge immediately after removing an expended one. Leaving cartridges
uninstalled can dry out the print head and may prevent the product from printing.

* Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.

* Do not shake, squeeze, or drop cartridges after opening their packages and do not tear the cartridge
labels; this can cause them to leak.

* Do not replace ink cartridges with the power off and do not move the print head by hand; otherwise,
you may damage the printer.

* Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to
print.

« If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came with it to
prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.

* Use an ink cartridge before the date printed on its package.
* Do not dismantle an ink cartridge. This could damage the print head.

* Do not disassemble the ink cartridges or maintenance box; you may get ink in your eyes or on your
skin.

« Store ink cartridges in a cool, dark place. Keep ink cartridges out of direct sunlight, and do not store in
high or freezing temperatures.

+ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature
for at least three hours before using it.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
» Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

» Ifthe LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.
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» Do not press too hard on the LCD screen or subject it to heavy impacts.
» Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.

 Ifthe LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson
for support.

* Do not subject your product to sudden changes in temperature or humidity; this may cause
condensation to develop inside the LCD screen and degrade its performance.

» The LCD screen may contain a few small bright or dark spots, and may display uneven brightness.
These are normal and do not indicate that the screen is damaged in any way.

Parent topic: Important Safety Instructions

Important Privacy Notice (Printer Serial Number)

As part of setup, your product's serial number will be sent to a secure Epson server so that you can be
eligible to participate in programs we may offer from time to time, including the Epson ink replenishment
program. You will have a separate opportunity to consent to participating in such programs.

If you have any questions concerning this process, you can contact us by using the Privacy Feedback
Form, or you can write to:

Epson America, Inc.
Attn: Privacy Coordinator
3131 Katella Avenue

Los Alamitos, CA 90720
Parent topic: Notices

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
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* Increase the separation between the equipment and receiver.
» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
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§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3131 Katella Ave., Los
Alamitos, CA 90720 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAlLegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the
selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
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law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.

c¢) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
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1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.

Parent topic: Notices

Trademarks

EPSON® and Epson Smart Panel® are registered trademark, EPSON Exceed Your Vision is a registered
logomark, and Epson Connect™, and Remote Print™ are trademarks of Seiko Epson Corporation.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, AirPrint, AirPrint logo, iPad, iPhone, iPod touch, Mac, macOS, and OS X are trademarks of Apple
Inc., registered in the U.S. and other countries. App Store is a service mark of Apple Inc., registered in
the U.S. and other countries.

Use of the Works with Apple badge means that an accessory has been designed to work specifically
with the technology identified in the badge and has been certified by the developer to meet Apple
performance standards.

Google® is a registered trademark and Android™, Google Drive™, Google Play™, Chromebook™, Google
Chrome™, and Gmail™ are trademarks of Google LLC.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
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General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

Parent topic: Notices

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
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Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (1) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution
© 2021 Epson America, Inc.
12/21
CPD-61341
Parent topic: Copyright Notice
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